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SYMANTEC LICENSE AND WARRANTY
NOTICE: SYMANTEC LICENSES THE ENCLOSED SOFTWARE 
TO YOU ONLY UPON THE CONDITION THAT YOU ACCEPT 
ALL OF THE TERMS CONTAINED IN THIS LICENSE 
AGREEMENT. PLEASE READ THESE TERMS CAREFULLY. IF 
YOU DO NOT AGREE TO THESE TERMS, THEN SYMANTEC 
IS UNWILLING TO LICENSE THE SOFTWARE TO YOU, IN 
WHICH EVENT YOU SHOULD RETURN THE FULL PRODUCT 
WITH PROOF OF PURCHASE TO THE DEALER FROM WHOM 
IT WAS ACQUIRED WITHIN SIXTY DAYS OF PURCHASE, 
AND YOUR MONEY WILL BE REFUNDED.

LICENSE AND WARRANTY:

The software which accompanies this license (the “Software”) 
is the property of Symantec or its licensors and is protected by 
copyright law. While Symantec continues to own the Software, 
you will have certain rights to use the Software after your 
acceptance of this license. Except as may be modified by a 
license addendum which accompanies this license, your rights 
and obligations with respect to the use of this Software are as 
follows:

You may:

(i) use the Software on one computer to clone, or apply an 
image of, a hard drive on that computer, or a portion thereof, 
to another hard drive on the same computer;
(ii) use the Software on that same computer to create an image 
file of a hard drive on that computer and store the image file 
on removable media for disaster recovery purposes;
(iii) use the Software to create a boot disk as described in the 
documentation for reapplying the hard drive image that was 
created for disaster recovery purposes to the hard drive on 
that same computer;
(iv) use the Software to clone a hard drive from that same 
computer to a replacement computer, in the manner described 
in the software documentation, and to use the Software on the 
replacement computer provided that the Software has been 
removed from the original computer;
(v) make one copy of the Software for archival purposes, or 
copy the Software onto the hard disk of your computer and 
retain the original for archival purposes;
(vi) after written notice to Symantec, transfer the Software on a 
permanent basis to another person or entity, provided that you 
retain no copies of the Software and the transferee agrees to 
the terms of this agreement.

You may not:

(i) use the Software commercially or non-commercially for the 
purpose of creating multiple computers or hard drives not 
connected to the original computer, with similar or identical 
configurations to that of the original computer or hard drive;
(ii) copy the documentation which accompanies the Software;
(iii) sublicense, rent or lease any portion of the Software;
(iv) reverse engineer, decompile, disassemble, modify, 
translate, make any attempt to discover the source code of the 
Software, or create derivative works from the Software; or
(v) use a previous version or copy of the Software after you 
have received a disk replacement set or an upgraded version 
as a replacement of the prior version, unless you donate a 
previous version of an upgraded version to a charity of your 
choice, and such charity agrees in writing that it will be the 
sole end user of the product, and that it will abide by the 
terms of this agreement. Unless you so donate a previous 

version of an upgraded version, upon upgrading the Software, 
all copies of the prior version must be destroyed.

Sixty Day Money Back Guarantee:

If you are the original licensee of this copy of the Software and 
are dissatisfied with it for any reason, you may return the 
complete product, together with your receipt, to Symantec or 
an authorized dealer, postage prepaid, for a full refund at any 
time during the sixty day period following the delivery to you 
of the Software.

Limited Warranty:

Symantec warrants that the media on which the Software is 
distributed will be free from defects for a period of sixty (60) 
days from the date of delivery of the Software to you. Your 
sole remedy in the event of a breach of this warranty will be 
that Symantec will, at its option, replace any defective media 
returned to Symantec within the warranty period or refund the 
money you paid for the Software. Symantec does not warrant 
that the Software will meet your requirements or that 
operation of the Software will be uninterrupted or that the 
Software will be error-free. 
THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL 
OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, 
INCLUDING THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 
AND NONINFRINGEMENT. THIS WARRANTY GIVES YOU 
SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS, 
WHICH VARY FROM STATE TO STATE.

Disclaimer of Damages:

REGARDLESS OF WHETHER ANY REMEDY SET FORTH 
HEREIN FAILS OF ITS ESSENTIAL PURPOSE, IN NO EVENT 
WILL SYMANTEC BE LIABLE TO YOU FOR ANY SPECIAL, 
CONSEQUENTIAL, INDIRECT OR SIMILAR DAMAGES, 
INCLUDING ANY LOST PROFITS OR LOST DATA ARISING 
OUT OF THE USE OR INABILITY TO USE THE SOFTWARE 
EVEN IF SYMANTEC HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.
SOME STATES DO NOT ALLOW THE LIMITATION OR 
EXCLUSION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION 
OR EXCLUSION MAY NOT APPLY TO YOU.
IN NO CASE SHALL SYMANTEC'S LIABILITY EXCEED THE 
PURCHASE PRICE FOR THE SOFTWARE. The disclaimers and 
limitations set forth above will apply regardless of whether 
you accept the Software.

U.S. Government Restricted Rights:

RESTRICTED RIGHTS LEGEND. All Symantec products and 
documentation are commercial in nature. The software and 
software documentation are “Commercial Items”, as that term 
is defined in 48 C.F.R. §2.101, consisting of “Commercial 
Computer Software” and “Commercial Computer Software 
Documentation”, as such terms are defined in 48 C.F.R. 
§252.227-7014(a)(5) and 48 C.F.R. §252.227-7014(a)(1), and 
used in 48 C.F.R. §12.212 and 48 C.F.R. 227.7202, as applicable. 
Consistent with 48 C.F.R. §12.212, 48 C.F.R. §252.227-7015, 48 
C.F.R. §227.7202 through 227.7202-4, 48 C.F.R. §52.227-14, and 
other relevant sections of the Code of Federal Regulations, as 
applicable, Symantec's computer software and computer 
software documentation are licensed to United States 
Government end users with only those rights as granted to all 



other end users, according to the terms and conditions 
contained in this license agreement. Manufacturer is Symantec 
Corporation, 20330 Stevens Creek Blvd., Cupertino, CA 95014. 

General:

This Agreement will be governed by the laws of the State of 
California. This Agreement may only be modified by a license 
addendum which accompanies this license or by a written 
document which has been signed by both you and Symantec. 
Should you have any questions concerning this Agreement, or 
if you desire to contact Symantec for any reason, please write: 
Symantec Customer Sales and Service, 20330 Stevens Creek 
Blvd., Cupertino, CA 95014. 
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C H A P T E R
 1
About Norton Ghost 
2001

What is Norton Ghost 2001?
Norton Ghost 2001 is a fast and reliable software solution to satisfy all of 
your computer disk cloning and copying needs. The high-performance 
utilities help you upgrade, back up, and recover entire disks or selected 
partitions. Norton Ghost can determine the partition sizes for the 
destination drive automatically. You can clone directly between two 
computers using a network, USB, or parallel connection.

This new version supports the Linux EXT2 file system, writes disk images 
directly to CDR/RW drives, clones from computer to computer, and 
supports Windows 2000 and Windows Millennium Edition. Designed for 
technically proficient computer users, Norton Ghost 2001 is based on 
Symantec Ghost Enterprise. Whether you want to back up your existing 
hard disk or clone it to a new one, Norton Ghost provides fast, safe 
computer cloning.

Understanding cloning and image files

Norton Ghost creates image files that contain all the information required 
to recreate a complete disk or partition. Image files are a useful way to 
store and reliably compress images of model system configurations, or to 
create backup copies of complete drives or partitions.

The image files created with Norton Ghost have a .gho extension by 
default. They can contain the entire disk or partitions in the disk. Image 
files support:

� Various levels of compression

� CRC32 data integrity checking
9



About Norton Ghost 2001 
� Spanning across removable media

Norton Ghost images contain only the actual data on a disk. If you have a 
9 GB drive with only 600 MB of data, the Norton Ghost image is about 600 
MB or smaller if you use compression.

If you also use the Ghost Explorer application, an image file companion 
utility, individual files from these image files can be recovered selectively 
without having to restore the complete partition or disk.

Norton Ghost components

Norton Ghost includes the following products and utilities:

� Norton Ghost executable

The Norton Ghost executable is what makes disk cloning possible. 
Because the executable is small with minimal conventional memory 
requirements, it can easily be run from a DOS boot disk or hard drive. 
Norton Ghost can restore a computer from an image file containing 
both Windows 98 and the full installation of Office 97 in about seven 
minutes.

Norton Ghost can make complete backups of disks or partitions, 
copying system files that other backup utilities miss. This makes it a 
great tool for disaster recovery operations.

� Ghost Boot Wizard

Creates boot disks that start Norton Ghost when you turn on your 
computer. Boot disks can be created for various cloning tasks. The 
wizard guides you to the drivers needed to create a boot disk. Ghost 
Boot Wizard is a Windows application.

� Ghost Explorer

Ghost Explorer is a Windows application that lets you add, recover, 
and delete individual directories and files from an image file.

� GDisk

A complete replacement for the FDISK and FORMAT utilities that 
allows on-the-fly formatting, better disk space utilization, batch mode 
operation, hiding and unhiding of partitions, secure disk wiping, and 
extensive partition reporting. GDisk is a DOS application.

Unlike FDISK, which uses interactive menus and prompts, GDisk is 
command line driven and offers quicker configuration of a disk’s 
partitions. 
10



Typical usage examples
Typical usage examples

Upgrade your hard drive

Use Norton Ghost to create a copy of your hard disk before upgrading to 
another one. Create an image file on removable media, or clone directly to 
another computer using a network, USB, or parallel connection. For even 
greater flexibility, Norton Ghost supports Linux EXT2, as well as Microsoft 
FAT and NTFS file systems. Norton Ghost determines the partition sizes for 
the destination drive automatically. Once the hard disk is installed, you can 
restore saved files by cloning the old hard disk onto the new hard disk, or 
restoring a saved image file.

Back up and recovery of your computer

Use Norton Ghost to create an image file of your computer on removable 
media, such as CD-R/RW, ZIP disks, and JAZ disks, and back up an entire 
hard disk or selected partitions. Use it for weekly backups or specific 
events, such as the installation of a new operating system. If you run out of 
space when backing up to a removable disk, Norton Ghost prompts you to 
insert another disk or save to an alternate location. Once an image is 
created, Norton Ghost can be used to restore the hard disk or any of the 
partitions saved.

Clone disks at optimum speed

Norton Ghost saves you time when copying one hard drive onto another, 
or to an image file on another hard drive, especially when both drives are 
installed in the same computer.

A wide range of computer hardware is available today with many choices 
of components such as processors, hard drives, and memory. Many 
modern computers are capable of transferring data at speeds of 1 Gigabyte 
per minute. This is an astounding speed especially considering that a 
compressed image of a drive containing a Windows 98 operating system 
will only be a few hundred megabytes in size. Using Norton Ghost to 
restore Windows 98 in this manner may take only seconds.
11
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C H A P T E R
 2
Getting started

Before installing Norton Ghost, you need to identify how you are going to 
clone; to an internal drive, over a parallel cable, and so on. Next, set up the 
hardware and software for the desired transfer method. Hardware 
requirements vary for the transfer methods.

Setting up Norton Ghost software
To set up the Norton Ghost software, complete the following tasks:

� Install Norton Ghost software on your computer.

For more information, see “Installation procedures” on page 20.

� Create an appropriate boot disk using Ghost Boot Wizard.

For more information, see “Creating boot disks” on page 23.

For information on using Norton Ghost to clone, create, and restore image 
files, see “Cloning disks” on page 33.

Setting up transfer methods
The following sections summarize the information you need to prepare 
devices and drives for Norton Ghost operation.

1 Identify what you want Norton Ghost to do: 

� Disk duplication

� Disk image file creation

� Disk creation from image file

� Partition duplication
13



Getting started 
� Partition image file creation

� Partition creation from image file

2 Select the hardware setup required to perform the operation.

One or more internal drives, and:

� No external connection

� Another peripheral device not needing additional setup (for 
example, JAZ or ZIP drive, or IDE CD writer)

� SCSI tape drive or CD writer requiring DOS ASPI driver setup

� Third-party device requiring DOS driver setup

� Peer-to-peer connection using LPT or USB ports 

� Peer-to-peer connection using TCP/IP and network interface cards 
connection

3 Set up the hardware and system for the method chosen.

a Ensure that both hard drives are installed correctly and the BIOS of 
the system is configured and correctly displays the valid parameters 
of the drives.

b Set up additional drivers required for other devices:

SCSI tape drive requiring DOS driver setup

Install the SCSI ASPI DOS driver in the config.sys file as outlined in 
SCSI Tape Drive documentation.

Third-party device requiring DOS driver setup

Install the DOS driver as outlined in device documentation.

Peer-to-peer connection: LPT or USB

� Configure LPT or USB port.

� Connect cabling.

� Use Ghost Boot Wizard to create an LPT and USB boot disk.

� Decide which machine is the master and which is the slave. You 
can dump an image from the master disk to the slave disk and 
restore from the slave disk to the master disk, but not the other 
way around. For more information, see “Peer-to-peer 
connections” on page 16.

Peer-to-peer connection: TCP/IP

� Install network interface card (NIC).

� Connect cabling.

� Create a Network Boot Disk with Ghost Boot Wizard.
14



Setting up transfer methods
� Select which machine is the master and which is the slave. You 
can dump an image from the master disk to the slave disk and 
restore from the slave disk to the master disk, but not the other 
way around.

Hardware requirements for Norton Ghost transfer modes

This table lists the hardware required for the different transfer methods.

Type of 
connection

Hardware

Peer-to-peer 
LPT/parallel 
port connection

Parallel connection cable and a bidirectional parallel port on 
each machine. ECP is the best option for connection and has a 
data transfer rate of approximately 5 MB/min.

For data transfer of approximately 19-25 MB/min, Norton 
Ghost provides support for the Parallel Technologies universal 
DirectParallel cable. See Appendix E, “USB and DirectParallel 
Cables” on page 97 for more information.

Peer-to-peer 
USB port 
connection

USB cable that supports a host-to-host connection and a data 
transfer of approximately 20-30 MB/min.

See Appendix E, “USB and DirectParallel Cables” on page 97 
for more information.

Peer-to-peer 
TCP/IP 
connection

Ethernet or Token Ring network interface card.
Established network connection, which includes one of the 
following:

� Crossover Ethernet cable 
(pins 1236 > 3612)

� Coaxial cable

� Standard cables with hub or MAU

SCSI tape driver DOS ASPI driver.
Tape media.

Removable 
media

Removable media drive and media.
Media drivers required to use in DOS.

CD-ROM usage CD-ROM writer.
Blank CD-R or CD-RW media.

See “Image files and CD writers” on page 50 for more 
information.
15



Getting started 
Internal drives

To work with internal drives, ensure that each of the drives is properly 
configured. This means that if fixed IDE drives are in use, the jumpers on 
the drives are set up correctly, and the BIOS of the machine is configured 
for the disk arrangement. Both the source and the destination drive must 
be free from file corruption and physical hard drive defects.

Local devices

To use Norton Ghost with a SCSI tape device, the tape device needs to 
have an Advanced SCSI Programming Interface (ASPI) driver for DOS 
installed. The driver is installed in the config.sys file as shown in the 
example below:

device=C:\scsitape\aspi4dos.sys

Refer to the documentation included with the SCSI tape device for further 
details.

Peer-to-peer connections

Peer-to-peer connections enable Norton Ghost to run on two machines and 
transfer drives and partitions, and to use image files between them.

The following table describes different cloning situations, and the master/
slave relationship.

Action Master Slave

Disk-to-disk copy Machine containing source 
disk

Machine containing 
destination disk

Disk-to-image file 
copy

Machine containing source 
disk

Machine receiving 
destination image file

Image file-to-disk 
copy

Machine containing 
destination disk

Machine containing source 
image file

Partition-to-partition 
copy

Machine containing source 
partition

Machine containing 
destination partition

Partition-to-image 
file copy

Machine containing source 
partition

Machine receiving 
destination image file

Image 
file-to-partition copy

Machine containing 
destination partition

Machine containing source 
image file
16



Setting up transfer methods
Peer-to-peer parallel port and USB connections

Connect both computers through the LPT or USB port with an appropriate 
transfer cable. Norton Ghost must be running under DOS on both 
computers. The parallel port must be set to bidirectional. ECP will give the 
best performance.

Select which computer is the master (the machine from which you control 
the connection), and which is the slave (the other machine participating in 
the connection). All operator input must occur on the master computer. 
Use the previous table to choose which machine will be the master and 
which will be slave.
17



Getting started 
18



C H A P T E R
 3
Installing Norton Ghost

This chapter details how to install Norton Ghost on your computer, and 
how to install the Norton Ghost executable.

System requirements
The Norton Ghost executable and GDisk run under DOS. The Norton 
Ghost installation CD includes a version of DOS so you can boot into DOS 
and run these components.

For PCs to be cloned

� IBM PC or 100% compatible

� DOS 5.0 or higher

� 386 SX processor or higher (486 or higher recommended)

� 8 MB RAM for Windows 95/98

� 16 MB RAM for Windows NT/2000

� 5 MB of available disk space

� VGA monitor (minimum)

� Microsoft compatible mouse recommended

� CD-ROM drive

� Windows 9x, NT 4.0, 2000 or Millennium Edition required for Norton 
Ghost Explorer and the Ghost Boot Wizard
19



Installing Norton Ghost 
Installation procedures

Installing Norton Ghost

To install Norton Ghost:

1 Insert the Norton Ghost CD into the CD-ROM drive and click Install 
Norton Ghost 2001.

2 Follow the instructions on the screen.

3 Complete registration information.

Manually installing Norton Ghost on a hard disk

You can install Norton Ghost using the installation CD or by copying the 
DOS-based applications directly onto your machine.

To manually install Norton Ghost on a hard disk:

1 Create a directory on the destination drive.

2 Copy ghostPE.exe and gdisk.exe to the directory from the Tools 
directory on the installation CD.

Note: If a Windows drag-and-drop or copy and paste operation is used 
instead of a DOS command, the files being copied from the CD retain 
their read-only attributes when copied to a floppy disk or hard disk. 
You must manually change the attribute on the Norton Ghost 
executable (ghostPE.exe) and all other files that will be updated or 
edited.

Uninstalling Norton Ghost

To uninstall Norton Ghost:

� If you installed Norton Ghost from the install program, do one of the 
following:

� Uninstall from Add/Remove Programs in the Control Panel.

� On the Windows taskbar, click Start > Programs > Norton Ghost 
2001 > Uninstall Norton Ghost 2001.

� If you manually copied the Norton Ghost files, delete the ghostpe.exe 
executable file and associated files.
20



Updating Norton Ghost
Updating Norton Ghost
LiveUpdate is a convenient method for registered users to obtain updates 
for Norton Ghost. LiveUpdate uses an Internet connection to connect to 
Symantec to see if updates are available for Norton Ghost. Updates can 
then be selected, downloaded, and installed.

Symantec does not charge for Norton Ghost updates. However, your 
normal Internet access fees apply.

To update Norton Ghost using LiveUpdate:

1 On the Windows taskbar, click Start > Programs > Norton Ghost 
2001 > Ghost Explorer.

2 On the Help menu, click LiveUpdate.

3 Follow the instructions that appear on the screen.
21
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C H A P T E R
 4
Using Ghost Boot 
Wizard to create boot 
disks

The Ghost Boot Wizard creates boot disks and guides you to the drivers 
needed.

Creating boot disks
The Ghost Boot Wizard lets you create:

� Boot disks enabling peer-to-peer services for USB and LPT

� Standard boot disks that enable the use of Norton Ghost on a single 
computer

� Network boot disks with network support for TCP peer-to-peer 
connections

� Boot disks with generic CD-ROM drivers that allow you to write a disk 
image to a CD

IBM DOS is supplied for the purposes of creating boot disks. The DOS files 
are installed automatically when creating the boot disk in Ghost Boot 
Wizard.

To open the Ghost Boot Wizard:

� On the Windows taskbar, click Start > Programs > Norton Ghost 
2001 > Ghost Boot Wizard.
23



Using Ghost Boot Wizard to create boot disks 
Standard boot disks with the option of LPT and USB support

To create a boot disk for use on a single computer or with support for 
LPT and USB cables:

1 Open the Ghost Boot Wizard.

2 Click Standard Boot Disk with LPT & USB Support, then click Next.

3 Do one or more of the following, then click Next:

� Click USB support to add support for USB to the boot disk.

� Click LTP support to add support for LPT to the boot disk.

� Click to clear USB support and LPT support to create a boot disk 
to run Norton Ghost on a single machine.

4 The default path to the Ghost executable is entered in the GhostPE.exe 
field.

If the executable has been moved or you want to use a different 
version of Ghost, type the correct path in the GhostPE.exe field.

5 In the Parameters field, type any required command line parameters, 
then click Next.

See Appendix A, “Command-line switches” on page 67 for a complete 
description of command-line switches.

6 In the Floppy Disk Drive field, enter the appropriate drive letter.

7 In the Number of disks to create field, enter the number of disks you 
want to create.

8 Click Format disk(s) first to format the disks before disk creation.

9 Click Quick Format to perform a quick format, then click Next.

Boot disks with network support

The Ghost Boot Wizard helps you create boot disks that provide network 
support for TCP/IP peer-to-peer connections.

You need to know the type of network card installed on your machines 
before you can start this process. Create different boot disks for every 
network card installed on your machines unless you use the multicard 
template.

To create a boot disk with network support:

1 Open the Ghost Boot Wizard.

2 Click Peer-to-Peer Network Boot Disk, then click Next.
24



Creating boot disks
3 Click the network driver for the particular make and model of the 
network card installed on the machine. Then click Next.

If the correct driver isn’t in the list, see “Adding network drivers to the 
Ghost Boot Wizard” on page 27 for instructions. To add more than one 
driver to the boot disk, see “Creating a multicard template” on page 26 
for instructions.

4 The default path to the Ghost executable is entered in the GhostPE.exe 
field. If the executable has been moved, or you want to use a different 
version of Ghost, type the correct path in the GhostPE.exe field.

5 In the Parameters field, type any required command line parameters, 
then click Next.

See Appendix A, “Command-line switches” on page 67 for a complete 
description of command-line switches.

6 Do one of the following and then click Next:

� Click DHCP will assign the IP settings if your network contains a 
DHCP server.

� Click The IP settings will be statically defined and complete the 
fields below this option if your network does not contain a DHCP 
server.

7 In the Floppy disk Drive field, enter the appropriate drive letter.

8 In the Number of disk to create field, enter the number of disks you 
want to create.

9 Click Format disk(s) first to format the disks before disk creation.

10 Click Quick Format to perform a quick format, then click Next.
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Boot disks with CD-ROM support

To create a boot disk that allows access to images stored on 
CD-ROM disks:

1 Open the Ghost Boot Wizard.

2 Click CD-ROM Boot Disk, then click Next.

3 The default path to the Ghost executable is entered in the GhostPE.exe 
field. If the executable has been moved, or you want to use a different 
version of Ghost, type the correct path in the GhostPE.exe field.

4 In the Parameters field, type any required command line parameters, 
then click Next.

See Appendix A, “Command-line switches” on page 67 for a complete 
description of command-line switches.

5 In the Floppy Disk Drive field, enter the appropriate drive letter.

6 In the Number of disks to create field, enter the number of disks you 
want to create.

7 Click Format disk(s) first to format the disks before disk creation.

8 Click Quick Format to perform a quick format, then click Next.

Creating a multicard template
Multicard templates allow a boot disk containing several NDIS2 drivers to 
be created. When the computer is booted, a special multicard driver checks 
the computer’s hardware to see if any of the NDIS2 drivers can be used to 
access the installed network card.

Refer to the Software License Agreement for use restrictions.

To create a template containing more than one driver:

1 Open Ghost Boot Wizard.

2 Select the type of boot disk you want to create.

3 Click Multicard Template, then click Next.

4 From the list of NDIS2 drivers, click the required drivers, then click 
Next. If you are creating a floppy disk from the boot disk, select no 
more than four or five drivers, as space is limited on a floppy disk.
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Adding network drivers to the Ghost Boot Wizard
The Ghost Boot Wizard includes drivers to over 80 network interface cards. 
If your driver isn’t in the list, you can add it to the wizard so it’s already set 
up the next time you need it.

To add a network driver to the Ghost Boot Wizard:

1 Open Ghost Boot Wizard.

2 Select the type of boot disk you want to create.

3 Click Add.

4 Click Packet Driver or NDIS2 Driver, then click OK.

Many manufacturers ship both drivers with their network cards so you 
generally have a choice of which one you use.

For packet drivers:

Packet drivers are usually DOS executables (with a .com or .exe file 
extension) that load from the autoexec.bat file before Norton Ghost 
loads. Norton Ghost communicates directly with the packet driver to 
use the services provided by the network card.

a In the Driver Executable field, enter the packet driver location so 
the Ghost Boot Wizard can copy the file to the current template. 
Packet drivers are generally included on the driver disk supplied 
with the network card. If you are installing the packet driver from 
the original disks that came with your network interface card, the 
packet driver will probably be inside a directory called Packet or 
Pktdrv.

b In the Parameters field, enter the command-line parameters if the 
network card requires them. These parameters vary from driver to 
driver and are usually optional with Plug and Play network cards. 
Consult the documentation that came with the network card, this is 
often in the form of a readme.txt file in the same directory as the 
driver itself. 

c Set the multicasting mode. Click Select Automatically to let Ghost 
determine the best multicasting mode based on the information in 
the packet driver. If the Select Automatically mode does not work, 
try Receive Mode 5. If that doesn’t work, try Receive Mode 6.

Although Norton Ghost does not support the multicasting of Ghost 
images, it might still be necessary to set a multicasting mode.
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For NDIS2 drivers:

NDIS2 drivers work with Microsoft’s Network Client, but Norton Ghost 
can also use them for multicasting. NDIS2 drivers are DOS drivers that 
load from the DOS config.sys file. Norton Ghost does not 
communicate with NDIS2 directly, but uses a shim (supplied by the 
Ghost Boot Wizard) to access the network card.

a Click Setup and locate the NDIS2 driver. In many cases Ghost can 
automatically determine the other parameters for your 
network.When locating the directory that contains the driver, look 
for a folder named Ndis or Ndis2. If you have the choice of DOS 
and OS2 folders, choose DOS.

b Review the following parameters and correct if necessary:

� Enter the DOS filename for the NDIS driver.

� In the Driver Name field, enter the internal name of the driver. 
The internal name of the driver is used when generating the 
protocol.ini configuration file and must always end with a ‘$’ 
character. If the Setup did not fill in this field for you, read the 
sample protocol.ini file in the same directory as the driver itself 
to find the driver name.

� In the Parameters field, enter the parameters that go into the 
protocol.ini configuration file. If you use Setup to automatically 
fill in this page, you will see the parameters that you need to 
adjust. For the majority of Plug and Play cards, all of the 
parameters are optional, so you can either accept the defaults or 
leave this box empty.

5 Click the Advanced tab, click Options, then click Next.

You may require additional drivers and programs to be loaded in order 
to use the network device attached to your computer. For example, 
many USB network devices need to load an extra driver for the USB 
port before the driver for the network device. In this dialog you can 
add files to the template and customize the autoexec.bat and config.sys 
files of the resulting boot disk.

If this template is a Multicard template then any additional files or 
modifications will be overridden by the settings in the Multicard 
template.

� Click New to add a file to the template. This is either a DOS driver 
or an executable program, but any type of file can be added. Files 
added to the template are displayed in the list to the right of the 
button.

� Click Delete to delete the selected file from the list.
28



Setting up a DOS boot disk without the Ghost Boot Wizard
� In the Autoexec.bat field, enter any additional autoexec.bat entries 
for the driver. The lines will be inserted before any network related 
commands, such as netbind.com or the packet driver executable.

� In the Config.sys field, enter any additional config.sys entries for 
the driver. The lines will be inserted before any driver-related 
devices are loaded to ensure that enabling drivers load before the 
main network device drivers specified in the network driver page.

Setting up a DOS boot disk without the Ghost 
Boot Wizard

Norton Ghost is a DOS-based application that should be run in DOS mode 
outside of Windows. On some systems, such as Windows NT, Windows 
2000, and other non-DOS operating systems, a DOS boot disk must be 
used to start the system to allow Norton Ghost to operate. Additional DOS 
drivers may be required to allow Norton Ghost to access local or network 
hardware. The configuration files on a DOS boot disk can be altered to 
load these drivers as detailed in “Setting up transfer methods” on page 13.

Normally, you should use the Ghost Boot Wizard to create a Ghost boot 
disk. Ghost Boot Wizard automatically adds IBM DOS to the boot disk. You 
only need to create a DOS boot disk if you want to use Norton Ghost with 
MS-DOS. You should not use a DOS boot disk for CD-ROM, TCP/IP, or 
other peer-to-peer connections.

To create a DOS boot disk for Norton Ghost within Windows 95/98:

1 Insert a blank floppy disk into the A drive of a Windows 9x machine.

2 Copy the system files onto the disk.

a Double-click the My Computer icon.

b Right-click the floppy drive, and click Format.

c Click Copy System Files.

3 Copy ghostpe.exe onto the boot disk. For example:

C:\> copy c:\progra~1\symantec\norton~1\ghostpe.exe a:\

4 Set up any drivers required for the transfer method. For more 
information, see “Setting up transfer methods” on page 13.
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To create a DOS boot disk for Norton Ghost in DOS:

1 Insert a blank floppy disk into the A drive of a DOS (Windows 9x) 
machine.

2 Copy the system files onto the disk.

Use the following DOS command to format and copy the system files 
to the unformatted disk:

C:\> format a: /s

3 Copy ghost.exe onto the boot disk. For example:

C:\> copy c:\progra~1\symantec\norton~1\ghostpe.exe a:\

4 Set up any drivers required for the transfer method. For more 
information, see “Setting up transfer methods” on page 13.
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Cloning disks and 
partitions

Starting Norton Ghost
Norton Ghost is a DOS-based application and should run in DOS mode 
outside of Windows. If you run Norton Ghost within Windows 95/98, note 
the following:

� Files may be in an open or changing state. If these files are cloned, the 
resulting destination files will be left in an inconsistent state.

� The partition where Windows 95/98 is installed must not be 
overwritten.

� If you overwrite a drive or partition, the system must be restarted.

� Norton Ghost will not automatically reboot the system.

� Hard disk sizes may be displayed smaller than their actual size. Norton 
Ghost will only be able to access the displayed destination size. The 
remaining space will not be used.

� Norton Ghost will fail if you try to overwrite any of the following:

� Windows swap files

� Registry files

� Open files

Norton Ghost cannot be run within Windows NT, Windows 2000, Linux, 
OS/2, or other non-DOS operating systems. To run Norton Ghost on a 
machine running a non-DOS operating system, use a Ghost boot disk.
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To start Norton Ghost:

� Do one of the following:

� Start the machine using a Ghost Boot Disk. For more information, 
see “Creating boot disks” on page 23.

� For Windows 95 and 98 machines, start the machine in DOS. At the 
DOS prompt, type:

C:> \progra~1\symantec\Norton~1 \ghostpe.exe

Running Norton Ghost in DOS may require additional DOS drivers 
to be started to allow Norton Ghost to access and use some 
hardware.

� You can boot your computer to DOS using the Norton Ghost 
installation CD if your computer is configured to boot from the 
CD-ROM drive. Consult your computer documentation for 
instructions.

Navigating without a mouse
If you have mouse drivers loaded then the mouse can be used to navigate 
your way around Ghost. You can always use the keyboard to navigate.

To use Norton Ghost without a mouse:

� Use arrow keys to navigate the menu.

� Press Tab to move from button to button.

� Press Enter to activate the selected button.

� Press Enter to select an item in a list.

Using Norton Ghost

To use Norton Ghost:

1 Start Norton Ghost. Optionally, add command-line switches. For 
information on the Norton Ghost command-line switches, see 
Appendix A, “Command-line switches” on page 67.

2 Select the transfer method and Norton Ghost operation.

3 Select source hard drive, partitions, or image file.
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4 Select destination hard drive, partition, or image file.

Make sure you select the correct destination to overwrite. In most 
cases, you will not be able to recover data from an incorrectly selected 
destination drive.

5 Follow the prompts on the screen and proceed with the clone.

6 Restart the machine.

Cloning disks
Disk cloning procedures are accessed from the main menu. To specify the 
transfer method, select one of the following options from the Norton Ghost 
main menu:

� Local

� LPT > Master

� USB > Master

� TCP/IP > Master

Cloning disk to disk

When you clone disk to disk, Norton Ghost copies the contents of one 
hard disk onto the other.

To clone disk to disk:

1 On the Norton Ghost main menu, click Local > Disk > To Disk.

2 In the Source Drive dialog box, select the source drive.

The Source Drive dialog box displays the details of every disk Norton 
Ghost can find on the local machine.

3 In the Destination Drive dialog box, select the destination drive.
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Warning: Choose carefully as this is the disk that is going to get 
overwritten.

If a peer-to-peer connection is established, this will be the slave 
machine’s disks. (If this is a local disk-to-disk copy, then the source 
disk will be unavailable for selection.)

4 Confirm or change the destination drive partition layout.

The Destination Drive Details dialog box displays a suggested partition 
layout for the destination drive. By default Norton Ghost tries to 
maintain the same size ratio between the new disk partitions. 
However:

� You can change the size of any destination FAT, NTFS, or Linux 
Ext2 partition at this stage simply by entering the new size in 
megabytes.

� You cannot enter a value that exceeds the available space, is 
beyond the file system’s limitations, or that is not large enough to 
contain the data held in the source partition.

5 Click OK.

6 When the “Proceed with Disk Clone?” question displays, check the 
details displayed and ensure the correct options are selected. Do one 
of the following:

� Click Yes to proceed with the disk cloning.

The system performs a quick integrity check of the file structure on 
the source disk and then copies the source disk to the destination. 
If you need to abort the process use Ctrl-C, but be aware that this 
leaves the destination disk in an unknown state.

Warning: Only click Yes if you are really sure you want to proceed. 
The destination drive will be completely overwritten with no chance of 
recovering any data.

� Click No to return to the menu.

7 When the disk clone is complete, reboot the machine. Symantec Disk 
Doctor, ScanDisk, or a similar utility can then be run to verify the 
integrity of the destination disk.
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Cloning a disk to an image file

Use this method to clone a disk to an image file. Then you can copy this 
image file to another disk or use the image file as a backup file.

To clone a disk to an image file:

1 On the Norton Ghost main menu, click Local > Disk > To Image.

2 In the Source Drive dialog box, select the source drive.

The Source Drive dialog box displays the details of every disk Norton 
Ghost can find on the local machine. 

3 In the File Locator dialog box, specify the image file destination and 
name.

The image file may reside on a local drive (but not the one that is 
being copied from). Local drives include writable CD, Tape, ZIP, JAZ, 
and LS120 Superdisk drives. 

When using peer-to-peer connections, the image file will be created on 
the slave machine.

It is advisable to write the image file to a bootable CD. If a bootable 
disk is placed in the floppy drive before the cloning session begins, 
Norton Ghost will copy the files onto the CD from the boot disk.

4 If required, in the Image file description dialog box, type a description 
of the image file. This description can be modified in Ghost Explorer.

5 Click Save.

6 When the “Compress Image File?” question displays, select the 
compression type:

� Click No for no compression (high speed).

� Click Fast for low compression (medium speed).

� Click High for high compression (slower speed).
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For more information on compression, see “Image files and 
compression” on page 45.

If spanning is enabled, Norton Ghost prompts for the additional disks 
and volumes. See “Image files and volume spanning” on page 46 for 
more information.

7 When the “Proceed with Image File Creation?” question appears, check 
the details displayed and ensure the correct options have been 
selected. Do one of the following:

� Click Yes to proceed with the image file creation.

The system performs a quick integrity check of the file structure on 
the source disk and then copies the source disk to the destination 
image file. If you need to abort the process use Ctrl-C, but be aware 
that this leaves the destination image file in an unknown state.

� Click No to return to the menu.

8 After the image file creation is complete, Norton Ghost can verify the 
integrity of the image file. On the main menu, click Check > Image 
File.

Cloning a disk from an image file

To clone a disk from an image file:

1 On the main menu, click Local > Disk > From Image.

2 In the File Locator dialog box, do one of the following:

� Type the path and file name of the image file.

� Browse to locate the image file.

Specify the drive or device and select the full path name. Note that the 
image file may reside on a local drive (but not the one that is being 
copied to). When using peer-to-peer connections, the file will be 
located on the slave machine.
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3 Press Enter.

4 In the Destination Drive dialog box, select the destination drive.

Warning: Choose carefully as this is the disk that is going to get 
overwritten.

The Destination Drive dialog box displays the details of every drive 
Norton Ghost can find on the local machine. The disk containing the 
source image file is not available for selection.

5 In the Destination Drive Details dialog box, confirm or change the 
destination drive partition layout.

The Destination Drive Details dialog box displays a suggested partition 
layout for the destination drive. By default Norton Ghost tries to 
maintain the same size ratio between the new disk partitions. 
However:

� You can change the size of any target FAT, NTFS, or Linux Ext2 
partition at this stage simply by entering the new size in megabytes.

� You cannot enter a value that exceeds the available space, is 
beyond the file system’s limitations, or is not large enough to 
contain the data held in the source partition.

6 Click OK.

7 When the final “Proceed with disk load?” question displays, check the 
details displayed and ensure the correct options have been selected. 
Do one of the following:

� Click Yes to proceed with the disk cloning.

Norton Ghost creates the destination drive using the source image 
file drive details. If you need to abort the process use Ctrl-C, but be 
aware that this leaves the destination drive in an unknown state.

Warning: Only click Yes if you are really sure you want to proceed. 
The destination drive will be completely overwritten with no chance of 
recovering any data.

� Click No to return to the menu.

For more information about how Norton Ghost handles spanned and 
split image files, see “Image files and volume spanning” on page 46.

8 When the disk image load is complete, reboot the machine. Run 
Symantec Disk Doctor, ScanDisk, or a similar utility to verify the 
integrity of the destination drive.
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Cloning partitions
Partition cloning procedures are accessed from the main menu. To specify 
a transfer method, select one of the following options from the Norton 
Ghost main menu:

� Local 

� LPT > Master 

� USB > Master

� TCP/IP > Master

Cloning from partition to partition

To clone from partition to partition:

1 On the main menu, click Local > Partition > To Partition.

2 In the Source Drive dialog box, select the source drive.

The Source Drive dialog box displays the details of every drive Norton 
Ghost can find on the local machine.

3 In the Source Partition dialog box, select the source partition.

The Source Partition dialog box displays the details of all the partitions 
on the selected source drive.

4 In the Destination Drive dialog box, select the destination drive.

The Destination Drive dialog box displays the details of every disk 
Norton Ghost can find on the destination machine. For peer-to-peer 
connections, the slave machine is the destination. 

5 In the Destination Partition dialog box, select the destination partition.

Warning: Choose an existing partition carefully as this is the partition 
that is going to be overwritten.
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The Destination Partition dialog box displays the details of all the 
partitions on the selected destination drive, plus an option to create a 
new partition if space is available. If you create a new partition, it can 
be resized during the cloning operation.

6 Click OK.

7 When the final “Proceed with Partition Copy?” question displays, check 
the details displayed and ensure the correct options have been 
selected. This is the last chance to back out. Do one of the following:

� Click Yes to proceed with the partition copy.

If you need to abort the process use Ctrl-C, but be aware that this 
leaves the destination drive in an unknown state.

Warning: Only click Yes if you are sure you want to proceed. The 
destination partition will be completely overwritten with no chance of 
recovering any data.

� Click No to return to the menu.

8 When the partition copy is complete, reboot the destination machine. 
Run Symantec Disk Doctor, ScanDisk, or a similar utility to verify the 
integrity of the destination partition.

Cloning a partition to an image file

To clone a partition to an image file:

1 On the main menu, click Local > Partition > To Image.

2 In the Source Drive dialog box, select the source drive.

The Source Drive dialog box displays the details of every disk Norton 
Ghost can find on the local machine.
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3 In the Source Partition dialog box, select the source partitions to be 
included in the destination image file and click OK.

The Source Partition dialog box displays the details of all the partitions 
on the selected source drive. Multiple partitions may be selected.

4 In the File Locator dialog box, select the image file and do one of the 
following:

� Type the path and file name for the disk image file.

� Browse to locate the image file.

The image file may reside on a local drive (but not the one that is 
being copied from). Local drives include writable CD, Tape, ZIP, JAZ, 
and LS120 Superdisk drives.

When using peer-to-peer connections, the image file will be created on 
the slave machine.

It is advisable to write the image file to a bootable CD. If a bootable 
disk is placed in the floppy drive before the cloning session begins, 
Norton Ghost will copy the files onto the CD from the boot disk.

5 Press Enter.

6 When the “Compress Image?” question displays, select the 
compression type.

� Click No for no compression (high speed).

� Click Fast for low compression (medium speed).

� Click High for high compression (slower speed).

Compression may affect the speed of operations. On selection of a 
compression level, Norton Ghost estimates the amount of space 
available for the destination image file. If there is insufficient space, 
Norton Ghost prompts you to enable spanning of image files.

If spanning is enabled, Norton Ghost prompts for the additional disks 
and volumes. See “Image files and volume spanning” on page 46 for 
more information.

7 When the final “Proceed with Partition Dump?” question displays, 
check the details displayed and ensure the correct options have been 
selected. Do one of the following:

� Click Yes to proceed with the image file creation.

The system performs a quick integrity check of the file structure on 
the source partitions and then copies the source partitions to the 
destination image file. If you need to abort the process use Ctrl-C, 
but be aware that this leaves the destination image file in an 
unknown state.
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� Click No to return to the menu.

8 After the image file creation is complete, Norton Ghost can verify the 
integrity of the image file. On the main menu, click Check > Image 
File.

Cloning a partition from an image file

To clone a partition from an image file:

1 On the main menu, click Local > Partition > From Image.

2 In the File Locator dialog box, do one of the following, then press 
Enter:

� Type the path and file name of the image file.

� Browse to locate the image file. 

Specify the drive or device and select the full path name. Note that the 
image file may reside on a local drive (but not the one that is being 
copied to). When using peer-to-peer connections, the image file will 
be located on the slave machine.

3 In the Source Partition dialog box, select the source partition for the 
image file.

The Source Partition dialog box displays the details of all the partitions 
in the image file.

4 In the Destination Drive dialog box, select the destination drive.

The Destination Drive dialog box displays the details of every disk 
Norton Ghost can find on the local machine.

5 In the Destination Partition dialog box, select the destination partition. 

Warning: Choose an existing partition carefully as this is the partition 
that is going to be overwritten.
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The Destination Partition dialog box displays the details of all the 
partitions on the selected destination drive, plus an option to create a 
new partition if space is available. If you create a new partition, you 
can resize it during the cloning operation.

6 When the final “Proceed with Partition Load?” question displays, check 
the details displayed and ensure the correct options have been 
selected. Do one of the following:

� Click Yes to proceed with the partition cloning.

Norton Ghost overwrites the destination partition using the 
partition details contained in the image file. If you need to abort the 
process use Ctrl-C, but be aware that this leaves the destination 
partition in an unknown state.

Warning: Only click Yes if you are really sure you want to proceed. 
The destination partition will be completely overwritten with no 
chance of recovering any data.

� Click No to return to the menu. 

For more information about how Norton Ghost handles spanned and 
split image files, see “Image files and volume spanning” on page 46.

7 When the partition copy is complete, reboot the destination machine. 
Run Symantec Disk Doctor, ScanDisk, or a similar utility to verify the 
integrity of the destination partition.

Adding switches to your cloning task
When defining your cloning task, you can include a number of options (or 
switches) that are usually entered via the command-line.

To add switches to your cloning task:

1 On the main menu, click Options.

2 On the different tabs, select the options to include in your current 
cloning task:

Tabs Command-line options

Span/CRC -span, -auto, -crcignore, -fcr

FAT 32/64 -f32,-f64, -fatlimit, -fnw

Misc -fro, -rb, -fx
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For a full description of these switches, see Appendix A, 
“Command-line switches” on page 67.

3 On the Save Settings tab, click Save Settings to confirm the list of active 
switches listed.

4 Click Accept to include the settings in the current task.

Cloning dynamic disks in Windows 2000
Norton Ghost supports the cloning of simple or mirrored volumes in 
dynamic disks. Cloning of spanned, striped, and RAID-5 volumes is not 
supported by Norton Ghost. You can dump an image from a partition to a 
dynamic disk. You can restore this image to a basic disk, but not on a 
dynamic disk.

You can only take a disk image of a dynamic disk if you use the image all 
(-ia) switch. The -ia switch performs a sector by sector copy of the entire 
disk. The disk that the image is to be loaded to must be identical to the 
source disk in every way. This function is only useful for creating a backup 
of an image. If you load an image created using -ia onto a drive with 
different geometry, Windows 2000 will not understand the dynamic disk.

Warning: If you load an -ia disk image of a dynamic disk onto a SCSI hard 
drive and you get the error, “Destination drive too small,” you must load 
the ASPI driver for the SCSI card. Without an ASPI driver, Norton Ghost 
does not always have the correct size of the SCSI drive and cannot 
distinguish if the drive is large enough to hold the image.

Image/Tape -ia, -ib, -id

-tapebuffered, plus options to: make safe, unbuffer, and 
eject the tape

HDD access -ffx, -fnx, -ffi, -fni, -ffs, -fns

Tabs Command-line options
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 6
Working with image 
files

Norton Ghost can create an image file that contains all the information 
required to recreate a complete disk or partition. Image files are a useful 
way to create backup copies of complete drives or partitions.

The image files created with Norton Ghost have a .gho extension by 
default. They can contain the entire disk or partitions in the disk. Image 
files support:

� Various levels of compression

� CRC32 data integrity checking

� Splitting of media files

� Spanning across volumes

Norton Ghost images contain only the actual data on a disk. If you have a 
9 GB drive with only 600 MB of data, the Norton Ghost image is about 600 
MB or smaller if you use compression.

If you also use the Ghost Explorer application, an image file companion 
utility, individual files from these image files can be recovered selectively 
without having to restore the complete partition or disk.

Image files and compression
Image files created in Norton Ghost support several levels of data 
compression. When using Norton Ghost in interactive mode, three 
compression options are provided: none, fast, and high. The Norton Ghost 
command-line switches provide access to nine levels of compression. The 
compression switch -z is detailed in Appendix A, “Command-line switches” 
on page 67.
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As a general rule, the more compression you use, the slower Norton Ghost 
operates. However, compression can improve speed when there is a data 
transfer bottleneck. There is a big difference in speed between high 
compression and no compression when creating an image file on a local 
disk. Over a network connection, fast compression is often as fast as, or 
faster than, no compression. Over a parallel cable, high compression is 
often faster than no compression because fewer bytes need to be sent over 
the cable. Decompression of high-compressed images is much faster than 
the original compression. The level of compression you should select 
depends on your own individual requirements.

Image files and CRC32
Cyclic Redundancy Checking (CRC) is a data error checking technique. 
CRC ensures that the original data that was written to the image file is the 
same as the data that is being used from the image file. The 32 value in 
CRC32 indicates the CRC technique uses a 32-bit value to store error 
checking information. The use of CRC32 increases detection of errors in 
the image file.

When image files are created, CRC32 details are embedded into the file to 
ensure image file corruption can be detected when it is being restored to 
disk. CRC32 is currently included on a file-by-file basis with FAT and Linux 
Ext2 partitions and on a MFT table basis for NTFS partitions. 

In addition to image file error detection, the CRC values can be used to 
verify that image files and partitions or disks are identical. This can offer an 
additional detection method against bad sector writes and other drive 
anomalies that may be missed during normal imaging checks.

A text file containing CRC values and associated file attributes can be 
generated using the -CRC32 command-line switch. These switches and 
functions are detailed in Appendix A. 

Image files and volume spanning

Standard image files

Standard image files consist of a single file that contains the contents of the 
complete disk or required partitions. This type of image file is used for 
storing system configurations on other hard drives and tape drives where 
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the volume is large enough and capable of holding the complete image file 
in one piece.

Size-limited, multi-segment image files

There are situations where it may not be practical to have a standard image 
file. Norton Ghost can split up an image file into segments (known as 
spans) that are limited to a user-specified size. This option is most 
commonly used to limit span sizes to 550 MB for later transfer onto 
CD-ROM. The default and maximum file size is 2 GB.

Spanned image files

Spanned image files are similar to size-limited, multi-segment image files. 
The difference is that each segment file (or span) of the image file is 
limited by the actual volume size of the media the image is being saved to. 
This allows you to specify a drive and file name and let Norton Ghost sort 
out when to request another volume or location for the remaining data. For 
example, this is very useful when using ZIP, JAZ, LS120 Superdisk, CD-R/
RW drives, and other drive types.

Warning: Spanning must be executed locally. If you try to use spanning 
over a peer-to-peer connection (LPT, USB, TCP/IP), a disk full error 
message will display. However splitting can be used in all situations.

Norton Ghost also allows size limiting of spans when spanning volumes, 
ensuring no span exceeds the maximum size.

With all image files, the only constraint on the selection of the destination 
volume is that it must not be part of the source selection; for example, it 
cannot be on a source disk or partition if that disk or partition is to be 
included in the image.

Spanning across multiple volumes and limiting span sizes

When creating an image file from a disk or partition, the destination drive 
might have insufficient space to store the image file. If Norton Ghost 
determines this is the case, it alerts you and asks whether to enable 
spanning. Norton Ghost assumes that compression reduces the size of the 
image by one-third when determining whether the image will fit. 
Alternatively, you can use the -span and -split command-line switches to 
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configure Norton Ghost to use image file splitting. See Appendix A, 
“Command-line switches” on page 67 for more information.

Before saving the disk contents to the image file, Norton Ghost displays the 
source and destination details and offers a chance to back out. The default 
is to back out.

Once the process starts, the image file creation continues until the 
destination volume is full. You are prompted either to press Enter to 
continue or to specify the location of the next span of the image file. Click 
OK to continue on the same form of media or enter a file name to span to 
a different location. 

For example, if you started spanning onto a JAZ disk and wish to span a 
3.0 GB drive onto JAZ disks, press Enter to continue on JAZ disks. If you 
would like to span across different forms of media, selecting FileName 
gives you the option to span onto a different location. 

Note: Record where the span segments are saved and the segment file 
names. Norton Ghost does not record the location and file name you 
selected.

Information about the partitions is stored at the start of the image file. This 
is updated at the end of the ghost process, which might require you to 
reinsert the first disk in the span set. Norton Ghost prompts you for the first 
disk in the span set and for subsequent volumes.

Loading from a spanned image

When loading a disk or partition from a spanned image file, the process is 
the same as loading from an unspanned image file. The loading procedure 
is the reverse of the saving procedure. However, during the loading of the 
spanned image file you are prompted for the location of the image file 
spans:

� Click OK to continue on the same form of media. For example, if you 
originally spanned onto a JAZ disk and wish to restore a 3.0 GB drive 
from JAZ disks, replace the disk and press Enter to continue from JAZ 
disks.

� If restoring from different forms of media, click FileName to restore 
from a different location. 
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� To load spanned images without prompting, choose Options from the 
Ghost main menu, and set the AutoName switch. For more 
information, see“Adding switches to your cloning task” on page 42.

Note: You need to know the span segment locations and filenames.

Image files and tape drives
Norton Ghost support of SCSI tape drives allows storage of a single image 
file onto a tape. When written onto the tape, there is no associated file 
system used, which means that you are unable to access the tape from a 
drive letter as if it were another storage drive. SCSI tapes do not support 
spanning to multiple tapes.

When using tape drives with Norton Ghost, the tape drive can be selected 
as the source or destination device in the File Locator window. Each SCSI 
tape device is shown as MTx, where x is a number starting at 0 and 
increasing incrementally for each drive present. For example, the following 
screen shows a tape drive MT0 available for use.

For Norton Ghost to access SCSI tape drives, a DOS ASPI driver must be 
installed prior to use. See “Setting up transfer methods” on page 13 for 
more information.

Norton Ghost in its default mode performs well with most SCSI tape 
devices. In some situations with older style SCSI tape devices and possibly 
with unreliable tapes, Norton Ghost may need to be configured to slow 
down or alter the way it uses the tape device. For these options, see 
“Norton Ghost command-line switches” on page 67.
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Image files and CD writers
Norton Ghost support of SCSI and IDE CD writers allows storage of a 
single image file onto one or more CD-R or CD-RW disks. The CDs can be 
read by any modern CD reader.

When using CD writers with Norton Ghost, a writer can be selected as the 
destination device in the File Locator window. Each writer is shown as 
CD-Rx, where x is a number starting at one and increasing incrementally 
for each writer present. For example, the following screen shows a CD 
writer available for use.

For Norton Ghost to access SCSI CD writers, a DOS ASPI driver must be 
installed prior to use. See “Updating Norton Ghost” on page 21 for more 
information.

Norton Ghost has been tested with the CD writers listed below. It will 
probably work with most SCSI and IDE writers produced in 2000. It may or 
may not work with older models. Use the latest firmware available for your 
CD writer. If your CD-R device is not listed below, use the Check Image 
feature of Norton Ghost to ensure that your image can be restored. For 
more information see “Cloning a disk to an image file” on page 35.

Use blank CD-R media or fully formatted CD-RW media for Norton Ghost. 
Fast-formatted CD-RW media is not suitable.

When creating an image on CD, you can make the CD bootable. You need 
an appropriate boot disk with CD drivers and MSCDEX loaded for this 
option. The Ghost Boot Wizard can create a suitable boot disk for you.
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Start from a disk with appropriate drivers and MSCDEX loaded. Norton 
Ghost restores images from CD as it does from other media, so the 
CD-reader must have a CD-drive letter.

� Acer CRW4432A, Acer 8432A, use firmware 5.FV or newer

� Creative Labs 4224, Creative Labs Blaster 8432

� HP 8200, 9110, 9210e

� Imation IMW0802201S

� Iomega ZipCD/Phillips PCRW404

� Lacie 8424 external, Lacie 8/2/20 SCSI external (sensitive to media 
used)

� LG CED-8080B

� Pacific Digital (Mitsumi) CR-480TE

� Plextor PX-8432, PX-R412, PX-R820, PX-W124, PX-W4220, PX-W8220

� Que PX-W8432Ti

� Ricoh MP9060A

� Smart and Friendly 8220, Smart and Friendly 2224 (sensitive to media 
used)

� Sony CRX140E, CRX145

� TDK VeloCD

� TEAC CDR-58S (8/24)

� Yamaha 6416S, 8424SZ, CRW8424E

Additional drive support might be available. Check the Norton Ghost 
product information on the Symantec Web site for a list of currently 
supported devices.
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 7
Norton Ghost utilities

Norton Ghost includes the following utility programs to make cloning 
easier:

� Ghost Explorer lets you quickly and easily restore files and directories, 
and work with files and directories within image files.

� Ghost GDisk is a replacement for Fdisk and Format that lets you 
perform on-the-fly partition formatting and reporting.

See “Ghost GDisk” on page 58 for more information.

Working with files in image files
Ghost Explorer allows you to quickly and easily restore files or directories 
from an image file. Using Ghost Explorer you can:

� View image file contents and save a list of files within an image file.

� Restore files or directories from an image file.

� Add, move, copy, delete, and launch files from and within an image 
file.

� Use drag-and-drop or cut-and-paste functionality to add files and 
directories from Windows Explorer to the image file.

� Set span sizes.

� Add a description of an image file.

Note: You can right-click a file or directory in Ghost Explorer to access a 
list of file commands.
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Ghost Explorer supports the following partition types:

To open Ghost Explorer:

� Click Start > Programs > Norton Ghost >  Ghost Explorer.

To view an image file:

1 Open Ghost Explorer and on the File menu, click Open.

2 Select an image file and click Open.

This displays the contents of the image file. It also displays the 
partition, directories, and files. 

3 To view the image file properties, on the File menu, click Properties.

To add or modify the image file description, type in the Description 
field.

Note: There may be some degradation of performance when viewing 
image files created with Norton Ghost V3.0. Ghost Explorer cannot 
view image files created with a version earlier than version 3.0. To 
check the Norton Ghost version in which your image file was created, 
see “Determining Norton Ghost image file version” on page 56.

To restore a file or directory from an image file:

1 Open the image file in Ghost Explorer, and select the file or directory 
to be restored.

2 On the File menu, click Restore.

3 Select where you want to restore the file or directory.

4 Click Restore to restore the file or directory to the chosen directory.

Note: You can also drag and drop a file from Ghost Explorer to 
Windows Explorer to restore it. 

� FAT12 � Linux Ext2

� FAT16 � NTFS

� FAT32
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Modifying image files in Ghost Explorer

With Ghost Explorer you can add files or directories from Windows 
Explorer to any image file that is not NTFS and was created in Norton 
Ghost version 6.0 or greater. You can also delete files from any image file 
that is not NTFS and was created in Norton Ghost v5.1c or a later version. 

To check the version of Norton Ghost used to create your image file, see 
“Determining Norton Ghost image file version” on page 56.

Adding, moving, and deleting files

Within image files, Ghost Explorer supports general Windows cut and 
paste operations, including copying, pasting, moving, deleting, and adding 
files to images. You can also drag and drop from Windows Explorer to 
Ghost Explorer.

Saving a list of files within an image file

This option saves a text file with a list of the directories (and optionally, 
files and their details) contained in the current image file.

To save a list of contents of an image file:

1 In Ghost Explorer, open the image file.

2 On the File menu, click Save Contents.

3 Specify whether to include directories only, or to include files and file 
details.

4 Select a directory, enter a file name, and click Save.

Setting span file sizes

Norton Ghost allows you to split an image file into smaller files called 
spans. The Span Split Point function in Ghost Explorer allows you to set 
the size of each span so that when you add files or directories, each span 
file does not get bigger than the specified size.

To set a span file size:

1 On the View menu, click Options.

2 In the Span Split Point (MB) field, type the required size.
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3 Click Autoname Spans if you want Ghost Explorer to choose a 
default name for additional span files it creates.

Compiling a file

If you add or delete files from an image file, the image file becomes 
fragmented. Norton Ghost takes longer to restore a fragmented image. 
Compiling a file defragments it, which improves performance when 
restoring.

Check the properties of the image file to see whether compilation is 
recommended.

To compile a file:

1 On the File menu, click Properties.

2 If compilation is recommended, on the File menu, click Compile.

3 Type a new name for the compiled file.

4 Click Save.

Determining Norton Ghost image file version

Whether you can add, delete, or view an image file, or move files within an 
image file depends on the version of Norton Ghost you used to create the 
image file. Ghost Explorer will not open a file created with a version of 
Norton Ghost earlier than 3.0. However, if the image file was created in 
Norton Ghost 3.0 or greater, you can determine the version by looking at 
its properties in Ghost Explorer.

To determine the version of Norton Ghost used to create your image 
file:

1 In Ghost Explorer, open the image file.

2 On the File menu, click Properties.

This displays the Properties window. The version of Norton Ghost 
used to create this image file is displayed beside Produced by Ghost 
version.
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Using Ghost Explorer from the command-line

You can start Ghost Explorer from an MS-DOS prompt by typing its path 
and name. For example:

C:\progra~1\symantec\Norton~1\ghostexp

Note: If Ghost Explorer is in the current directory, or in a directory on your 
path, you do not need to type the path name. 

You can also provide a Ghost image file as an argument for Ghost Explorer 
to open. For example:

ghostexp n:\images\myimage.gho

If Ghost Explorer reports a corruption in your image file, you may be able 
to get further details of the nature of the corruption. Normally, you will 
only use these options when asked to do so by Ghost Explorer technical 
support. Start the program with one of the following arguments:

The reports are presented to you as dialog boxes. You can use all switches, 
or use -d7 to turn on all options. 

Ghost Explorer has a batch mode where it carries out a single command 
and then exits. In this version, batch mode supports only the saving of the 
contents listing to a text file. To use this mode, specify one of the following 
switches:

See “Saving a list of files within an image file” on page 55 for more 
information on this command.

-d1 Reports on corruptions or significant events in FAT file systems.

-d2 Reports on corruptions or significant events in NTFS file systems.

-d4 Reports on corruptions or significant events in Ext2 files.

-t Save the list of directories in the dump file to a file with the same 
name as the image file but with an extension of .txt.

-tf Save a list of directories and files.

-tv Save a verbose listing of directories and files.

-t[vf]=filename Save the list to the file specified.
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If Ghost Explorer reports that a spanned or split image is corrupt, without 
ever prompting for the second part of the image, it may not recognize that 
the image is split. Starting with the -split argument forces Ghost Explorer to 
treat an image as a split image.

The image index created by versions of Norton Ghost prior to 5.1c did not 
correctly handle long file names containing double byte characters, such as 
file names in Asian or Eastern European languages. Ghost Explorer may be 
able to display these names properly by reading them directly from the 
image file instead of from the index, although the loading of the image will 
be much slower. Use the switch -ignoreindex to force this behavior.

Ghost GDisk
GDisk is a complete replacement for the Fdisk and Format utilities that 
offers:

� On-the-fly formatting.

� The ability to hide a partition or make a hidden partition visible. This 
option allows for more than one primary DOS partition with different 
versions of the appropriate operating system on each partition. The 
ability to hide partitions allows the computer to be used to boot into 
the selected bootable partition, ignoring other installations of the same 
operating system in other hidden partitions.

� Extensive partition reporting.

� High security disk wiping. You have the option of wiping your disk to 
the U.S. Department of Defence standard or even higher security.

Unlike Fdisk, which uses interactive menus and prompts, GDisk is 
command-line driven. This offers quicker configuration of a disk's 
partitions and the ability to define GDisk operations in a batch file.

To run Ghost GDisk:

1 Restart your machine in DOS mode.

2 Next to the DOS prompt, type: 

C: \progra~1\symantec\Norton~1\gdisk 

followed by the required disk and switches.
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Overview of main command-line switches

GDisk has eight main modes of operation, the first four of which 
correspond to the menu options in the Fdisk main menu. The mode in 
which GDisk operates is selected by one of the following switches: 

Online help for command-line switches

An overview of the eight modes of operation and their switches may be 
displayed by using the help switch:

C:\progra~1\symantec\Norton~1\gdisk /?

Note: An additional switch not shown in the help text is the /VERSION 
switch. This switch displays the version information for the GDisk 
executable.

More detailed help is available by qualifying the help command with the 
switch for one of the main eight modes listed in the table above. 

For example, to view the detailed help file for Hide, type the following 
command line:

C:\progra~1\symantec\Norton~1\gdisk /hide /?

Create /cre Creating partitions: primary DOS partitions, 
extended DOS partitions

Delete /del Deleting partitions of any type, including non-DOS 
partitions

Status, (default) /status Listing information on the specified fixed disk and 
its partitions

Activate /act Activating and deactivating a partition (nominating 
it as the bootable partition)

Hide /hide Hide an existing partition or unhide a hidden 
partition

Reinitialize MBR /mbr Reinitializing the Master Boot Record

Batch /batch Batch-mode command execution

Disk wipe /diskwipe Wipes the content of the whole disk
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Switches common to all GDisk commands

You can use the following switches for any of the main eight operations:

Creating a partition

The create switch creates a partition of the specified type using the largest 
block of unused disk space. The partition is not formatted during the 
operation unless the /for switch is used. See below. You cannot create a 
dynamic disk partition.

The syntax for this command is as follows:

gdisk disk /cre {/pri| /ext| /log} [/sz: {MB|pcent{p|%}}]
[ /for [/q] [/v[:label]] ] [/-32] [/ntfat16]

/x Prevents GDisk from using extended disk access support. This may result 
in GDisk not being aware of the full capacity of the disk.

/i Prevents GDisk from using direct IDE disk-access support. This may result 
in GDisk not being aware of the full capacity of the disk.

/s Prevents GDisk from using direct SCSI disk-access support. This may 
result in GDisk not being aware of the full capacity of the disk.

/y Suppress prompting to confirm the operation. However, if you do not use 
this switch you will not necessarily be prompted before a partition is 
deleted or another possibly destructive operation is executed.

/sure Suppress prompting to confirm the operation. However, if you do not use 
this switch you will not necessarily be prompted before a partition is 
deleted or another possibly destructive operation is executed.

/r Causes GDisk to reboot the machine if the operation has been successful.

disk The physical fixed disk, 1 to 8.

/cre Create a DOS partition or logical DOS drive.

/pri Create a primary DOS partition.

/ext Create an extended DOS partition. 

/log Create a logical DOS drive in the extended DOS partition.

/sz:MB Specifies the size of the partition in megabytes (MB). This is 
rounded up to the nearest cylinder.
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Reinitializing the Master Boot Record

Use the /mbr switch to rewrite the boot code in the Master Boot Record. 
The usual reason for needing to reinitialize the MBR is to eliminate a boot 
sector virus residing there. You can also use the /mbr switch with the /
wipe option to delete a dynamic disk.

Note: This switch has to be used when deleting Linux partitions if LILO 
resides in the MBR.

/sz:pcent{p|%} Specifies the size of the partition as a percentage of the total disk 
size, not the available disk space.

/for Format the new partition once it has been created. Unless the /
ntfat16 or /-32 switches are used, the partition type is determined 
by the following:

� If the partition is less than 16MB: FAT12

� If the partition is between 16MB and 512MB: FAT16

� If the partition is greater than 512MB: FAT32

/q Performs a quick format if used in combination with the /for 
switch. If you do not use this switch, then GDisk will do a 
surface scan of the partition and mark any bad sectors.

/v[:label] Use in combination with the /for switch to give the new 
formatted partition the specified label.

/-32 Partition is not formatted as FAT32. Limits primary and logical 
partitions to 204MB. Partitions over 16MB will be formatted as 
FAT16. This switch is useful if the operating system running does 
not support FAT32, for example, Windows NT4.

/ntfat16 Partition is not formatted as FAT32, but 64KB, cluster FAT16 is 
allowed. This limits primary and logical partitions to 4097MB. 
Partitions over 16MB are formatted as FAT16. Windows 9x and 
DOS systems are unable to access partitions that are over 204MB 
and were created with this switch.
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The syntax for this command is as follows:

gdisk disk /mbr [/wipe]

Displaying information about disks

The status switch displays information about the fixed disks and partitions 
on a disk, including the model of the disk. To display the information 
about the partitions on a disk, you must specify the disk number. The 
syntax for this command is as follows: 

gdisk [disk] [/status] [/raw] [/lba] [/ser]

Batch mode

Use the batch mode switch, /BATCH, to perform multiple GDisk 
operations with a single command. Batch commands can either be 
supplied interactively at a prompt or in a pre-prepared text file.

If the name of a text file is supplied along with the batch mode switch, 
GDisk opens the file and executes the commands within it until all 
commands have been executed or one of the commands encounters an 
error:

C:\> gdisk /batch:cmds.gg

If the batch mode switch is supplied without a file name, GDisk will 
prompt for the commands to execute.

Command-line arguments that apply to all of the batch commands can be 
specified on the original command line along with the batch mode switch. 

disk The physical fixed disk for which to get partition information, 1 to 8.

/mbr Reinitializes the boot code in the Master Boot Record.

/wipe Delete the partition on the disk.

disk The physical fixed disk for which to get partition information, 1 to 8

/raw Displays the contents of the partition table in CHS form if used with the 
disk switch

/lba Displays the contents of the partition table in logical block form if used 
with the disk switch

/ser Displays the serial number of the disk
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The lines found in the batch file (or typed at the prompt) are appended to 
the already partially formed command line.

Here is an example batch command file called two-new.gg. Blank lines 
and lines starting with the hash symbol are considered to be comments. 
These lines are ignored. (In this example, the commands do not specify the 
fixed disk on which to operate.)

# delete all partitions

/del /all

# create formatted FAT16 primary DOS partition

/cre /pri /-32 /for /q

/cre /ext

# create formatted FAT16 logical DOS partition

/cre /log /-32 /for /q

The following command deletes all partitions and creates two new ones on 
the second fixed disk with confirmation prompting turned off:

gdisk 2 /y /batch:two-new.gg 

The four commands that will be executed are a combination of the original 
command plus the commands from the batch file:

gdisk 2 /y /del /all

gdisk 2 /y /cre /pri /-32 /for /q

gdisk 2 /y /cre /ext 

gdisk 2 /y /cre /log /-32 /for /q

Batch files may be nested recursively, so if a second file called 
STD_INIT.GG contained the following lines:

1 /batch:two-new.gg 

2 /batch:two-new.gg 

then this command performs the actions of two-new.gg on both fixed 
disks:

gdisk /batch:std-init.gg

FAT16 partitions in Windows NT

Windows NT allows FAT16 partitions to be up to 4 GB in size using 64K 
clusters. GDisk can create a FAT16 partition using 64K clusters when the 
/NTFAT16 switch is added to the create partition command line. This 
switch disables the creation of FAT32 partitions and allows FAT16 partitions 
to be created up to 4 GB. 
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Note: DOS and Windows 9x do not support FAT16 partitions using 64K 
clusters and are limited to 2 GB FAT16 partitions.

Deleting and wiping your disk

GDisk provides a choice to delete data and partitions on your disk or wipe 
your entire disk. You cannot delete a dynamic disk partition.

� The switch /del/all deletes all partitions that are on the disk. Partitions 
are removed. Any other space that has not been used for creating a 
partition will not be deleted. Deleting an extended partition also 
deletes any logical partition within it.

� The /diskwipe switch wipes the whole disk, partitions, partition table, 
MBR and all used and unused spaces.

The syntax for the delete switch command is as follows: 

gdisk disk /del {/pri[:nth]|/ext[:nth]|/log:nth|/p:partn-no|/all} 
[/qwipe|/dodwipe|/customwipe:n]

The syntax for the diskwipe switch is as follows:

gdisk disk /diskwipe [dodwipe| /customwipe:n]

disk The physical fixed disk, 1 to 8.

/del Delete a DOS partition or logical DOS drive.

/pri[:nth] Delete the nth primary DOS partition, the default is 1.

/ext[:nth] Delete the nth extended DOS partition, the default is 1. Also 
deletes any logical partitions in the extended partition.

/log:nth Delete the nth logical DOS drive from the extended DOS 
partition.

/p:partn-no The partition to delete. Use the number reported by Gdisk in 
standard display mode (not using /lba or /raw) for partn-no.

/all Delete all partitions.

/qwipe Overwrites the partition’s data area before deleting the partition. 
Makes one pass of the disk.
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For example:

� gdisk 1 /del /all /qwipe completes one pass to delete all partitions and 
data on disk 1.

� gdisk 1 /del /p:2 /qwipe wipes partition 2 on disk 1 with one pass.

� gdisk 1 /diskwipe /customwipe:15 wipes the entire disk with 15 
passes.

Activate or deactivate a partition

The syntax for this command is as follows: 

gdisk disk /[-]act /p:partn-no

Hide or unhide a partition

The syntax for this command is as follows: 

gdisk disk /[-]hide /p:partn-no

/dodwipe Overwrites the partition’s data area before deleting the partition. 
Makes 7 passes of the disk. This is the security standard for the 
U.S. Department of Defence.

/customwipe:n Overwrites the partition’s data area n times before deleting the 
partition. n can be set from 1 to 100. /customwipe:7 is equivalent 
to /dodwipe.

disk The physical fixed disk, 1 to 8.

/act Activate a partition.

/-act Deactivate a partition.

/p:partn-no Partition to activate or deactivate. Only primary partitions can be 
activated. Use the number reported by GDisk in standard display 
mode (not using /lba or /raw) for partn-no.

disk The physical fixed disk, 1 to 8.

/hide Hide a partition.

/-hide Unhide a partition.
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Support for large hard disks

GDisk includes large disk drive support for IDE and SCSI hard drives 
(those disks that exceed the 1024 Cylinder BIOS limitation, which translates 
to a capacity greater than 7.8 GB). GDisk can directly access hard disks 
through the IDE controller or ASPI interface provided by an ASPI driver. 
Care should be taken when creating partitions for operating systems with 
inherent partition size limitations.

Remember the following information when creating partitions for use in 
Windows 95/98:

� On systems with a PC BIOS that does not support interrupt 13h 
extended disk services, care should be taken to ensure the partitions 
created can be used as intended. When a primary partition or extended 
partition starts or ends past a 7.8 GB limit of the hard drive, it will not 
be accessible on such systems during the booting of Windows or in 
DOS-only mode. This affects all logical partitions contained within an 
extended partition starting or ending past the limit.

Remember the following information when you create partitions for use in 
Windows NT:

� According to the Microsoft Support Knowledgebase, Windows NT 
NTFS bootable partitions cannot exceed 7.8 GB (8,455,716,864 bytes). 
This information is fully detailed in the Windows Knowledgebase 
Article “Windows NT Boot Process and Hard Disk Constraints,” Article 
ID: Q114841.

Non-bootable NTFS partitions do not have this size limitation.

� NT cannot boot from partitions that start or end over the 1024-cylinder 
boundary. If this condition exists, NT reports a “Boot Record Signature 
AA55 Not Found” error message.

� Windows NT does not support drives larger than 7.8 GB unless you 
install Service Pack 4 or apply the ATAPI hot fix to Service Pack 3. This 
information is included in the Windows Knowledgebase Article “IBM 
DTTA-351010 10.1 GB Drive Capacity Is Inaccurate,” Article ID: 
Q183654.

/p:partn-no Partition to hide or unhide. Use the number reported by GDisk 
in standard display mode (not using /lba or /raw) for partn-no.
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Norton Ghost command-line switches
Norton Ghost can be run:

� Interactively with no command-line switches

� Interactively with selected switches 

The Norton Ghost command-line switches are used to alter Norton Ghost 
behavior and automate procedures. To list Norton Ghost command-line 
switches, type one of the following:

ghostpe.exe -h

ghostpe.exe -?

A hyphen (-) or a slash (/) must precede all switches except @. Switches 
are not case sensitive. They can be entered in upper, lower, or mixed case.

@filename

Specifies a file containing additional command-line switches that should be 
read. Filename indicates the path and file name of the command-line 
switch file. The command-line switch file can include any Norton Ghost 
command-line switch, except for -afile and -dfile. The Norton Ghost 
command-line switch file must be a text file with each switch on a new 
line. This feature allows you to exceed the DOS command-line limit of 150 
characters.

Example:

ghostpe.exe @ghswitch.txt
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-clone

The syntax for this switch is:

-clone,MODE={operation},SRC={source},DST={destination}, 
[SZE{size},SZE{size}.......]

Clone operation switch. This switch allows automation of Norton Ghost 
operations and has a series of arguments that define the operation 
parameters. No spaces are allowed in the command line. The number of 
size switches depends on the number of partition sizes you want to 
specify. There may be none.

MODE={copy | load | dump | pcopy | pload | pdump}

MODE defines the type of clone command:

SRC={disk | file | tape }

SRC defines the source for the operation selected by the clone mode 
option:

copy Disk-to-disk copy

load File-to-disk load 

dump Disk-to-file dump

pcopy Partition-to-partition copy

pload File-to-partition load

pdump Partition-to-file dump, allows multi-part Ghost dump selection for file

disk drive number Source disk drive number - numbers start at 1. 
For example, SRC=1

A partition on a drive can also be specified. 
Numbers start at 1. For example, SRC=1:2

file filename The source image filename. For example, 
SRC= g:\source.gho

A partition in an image file can also be 
specified. For example, SRC=g:\source.gho:2

Files can also be read from a CD-ROM drive.
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DST={disk | file | tape | cdwriter}

DST defines the destination location for the operation:

tape @MTx The tape drive number. Numbers start at 0. For 
example, SRC=@MT0

A partition on a tape can also be specified. For 
example, SRC=@MT0:3

disk drive The destination disk drive number. For 
example, DST=2

A partition on a drive can also be specified. For 
example, DST=2:1

To create a new partition, type a destination 
partition one greater than the existing number 
of partitions, if there is enough free space.

file filename The destination image filename. For example, 
DST= g:\destination.gho

tape @MTx The tape drive number. Numbers start at 0. For 
example, DST=@MT0

cdwriter @CDx The CD writer drive number. Numbers start at 1. 
For example, DST=@CD1
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Cloning combination options

SZE{E | F | L | n={nnnnM | nnP| F | V}}

SZE sets the size of the destination partitions for either a disk load or disk 
copy operation. This is optional but multiple partition size switches are 
supported. 

Available options

Mode Source Destination

copy disk disk

load file
tape

disk

dump disk file
tape
cdwriter

pcopy disk:partition disk:partition

pload file:partition
tape:partition

disk:partition

pdump disk:partition:partition:partition

More than one partition can be specified

file
tape
cdwriter

n=xxxxM Indicates that the nth destination partition is to have a size of 
xxxx MB (for example, SZE2=800M indicates partition two is to have 
800 MB).

n=mmP Indicates that the nth destination partition is to have a size of mm 
percent of the target disk. Due to partition size rounding and 
alignment issues, 100% physical use of disk space may not be 
possible.

n=F Indicates that the nth destination partition is to remain the same size 
in the destination as it was in the source. This is referred to as fixed 
size.

n=V Indicates that the partition may be made bigger or smaller depending 
on how much disk space is available. This is the default.

E The sizes of all partitions remain fixed. 
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Examples of clone switch usage

The following table describes clone switches and their functions.

F The sizes of all partitions except the first remain fixed. The first 
partition uses the remaining space. 

L The sizes of all partitions except the last remain fixed. The last 
partition uses the remaining space. 

Use this switch To do this

ghostpe.exe -clone,mode=copy,src=1,dst=2 Copy local disk one to local disk 
two.

ghostpe.exe -clone,mode=dump,src=2,dst=c:\drive2.gho -lpm

The slave machine can be started with ghostpe.exe -lps

Connect using LPT to another 
machine running Norton Ghost in 
slave mode, and save a disk image 
of local disk two to the remote file 
c:\drive2.gho

ghostpe.exe -clone,mode=pcopy,src=1:2,dst=2:1 Copy the second partition of the 
local disk one to the first partition 
of local disk two.

ghostpe.exe -clone,mode=load,src=g:\2prtdisk.gho,dst=2,
sze1=60P,sze2=40P

Load disk two from an image file 
and resize the destination 
partitions into a 60:40 allocation.

ghostpe.exe -clone,mode=copy,src=1,dst=2,sze2=F Clone a two partition disk and 
keep the second partition on the 
destination disk the same size as 
on the source disk, and allow the 
first partition to use the remaining 
space, leaving no unallocated 
space.

ghostpe.exe-clone,mode=load,src=g:\3prtdisk.gho,dst=1,sze1=
450M,sze2=1599M,sze3=2047M

Load disk one from an image file 
and resize the first partition to 450 
MB, the second to 1599 MB, and 
the third to 2047 MB.

ghostpe.exe -clone,mode=load,src=g:\2prtdisk.gho,dst=1,szeL Load a disk from an image file 
and resize the last partition to fill 
the remaining space.
72



Norton Ghost command-line switches
-CRC32

The -CRC32 switch allows making a list of the files on a disk or partition, or 
in an image file with CRC values for each, and to verify that list against the 
original or a clone. The purpose is to allow both quick listing of the 
contents of an image file and verification that a disk created by Norton 
Ghost contains the same files as the original. CRC checking works file by 
file with FAT partitions. NTFS partitions are CRC-checked within an image 
file by each MFT table. It is not possible at present to obtain a list of files 
failing a CRC check with an NTFS file system. When a CRC file is created 
for an NTFS partition, only a single CRC value is generated. You can also 
create a CRC file from an image file, and verify against a disk.

The full syntax for this switch is:

-CRC32,action={create|verify|pcreate|pverify|

dcreate|dverify},src={{Disk Spec}|{Part Spec}|

{File}},{crcfile={File}|vlist={File}|vexcept=

{File}}

Note: Spaces are not allowed within the -CRC32 switch.

crcfile={File}::ASCII CRC32 file - default=ghost.crc

vlist={File}::Verification list file - default=ghost.ls

vexcept={File}::Verification exception file - no default

The possible actions (with descriptions) are:

ghostpe.exe -clone,mode=copy,src=2:2,dst=@MT0 Create an image file of the second 
partition in disk 2 onto the first 
tape drive.

ghostpe.exe clone,mode=pdump,src2:1:4:6,dst=d:\part246.gho Create an image file with only 
selected partitions.

This is an example of selecting 
partitions 1, 4, and 6 from disk 2.

create Create an ASCII CRC32 file from a disk.

verify Verify a disk from a CRC32 file.

Use this switch To do this
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pcreate Create an ASCII CRC32 file from a partition.

pverify Verify a partition from an ASCII CRC32 file.

dcreate Create an ASCII CRC32 file from an image file.

dverify Verify an image file from an ASCII CRC32 file.
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Examples of -CRC32 usage

Use this switch To do this

ghostpe.exe -fcr Create a CRC32 file (called 
ghost.crc) while making an image 
file.

ghostpe.exe -fcr=d:\test.crc Create a CRC32 file while making 
an image file with a different 
name.

ghostpe.exe -CRC32,action=create,src=1,crcfile=ghost.crc Create a list of files and CRC32 
values for a disk.

ghostpe.exe -crc32,action=dverify,src=x:dumpfile.gho

crcfile=ghost.crc

Verify the list against an image 
file.

ghostpe.exe -crc32, 
action=pverify,src=1:2,crcfile=filename.crc:2

This will verify that partition 2 on disk 1 is the same as partition 
2 in the crc file.

Verify partition in an image file 
with multiple partitions.

ghostpe.exe -crc32,action=create

Note that the default disk is the primary drive, the default ASCII 
CRC32 file is ghost.crc.

Create an ASCII CRC32 file from 
the primary hard drive.

ghostpe.exe -CRC32,action=create,src=2,crcfile=myfile.txt

Same as previous except you specify the disk and ASCII CRC32 
file. This example uses disk 2 as the source drive and the 
outfile myfile.txt.

Create an ASCII CRC32 file.

ghostpe.exe -CRC32,action=verify

Once again, the default disk is the primary drive and the default 
ASCII CRC32 file is ghost.crc (in the current directory). In 
addition, the default verification list file is ghost.ls.

Verify the contents of the primary 
disk against a CRC32 file.
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vexcept=filename

Specifies files that are not checked with CRC. This is normally used to 
exclude files that are always changed on boot. A sample exception file 
follows:

[ghost exclusion list]

\PERSONAL\PHONE

[partition:1]

\WINDOWS\COOKIES\*.*

\WINDOWS\HISTORY\*

\WINDOWS\RECENT\*

\WINDOWS\USER.DAT

\WINDOWS\TEMPOR~1\CACHE1\*

\WINDOWS\TEMPOR~1\CACHE2\*

\WINDOWS\TEMPOR~1\CACHE3\*

\WINDOWS\TEMPOR~1\CACHE4\*

[partition:2]

*\*.1

[end of list]

The exclusion list is case-sensitive; all files should be specified in upper 
case. The *wildcard follows UNIX rules, it is more powerful than the 
MS-DOS *. In particular it matches the . as well as any other character, but 
other characters can follow the *. Thus, a wildcard of *br* matches any files 
containing the letters “br”, for example, brxyz.txt, abr.txt, and abc.dbr.

ghostpe.exe -CRC32,action=verify,src=1,crcfile=myfile.txt

vlist=myfile.out

Same as previous but specify the disk, CRC file, and list file. 
This example uses disk 1 as the source drive, myfile.txt as the 
ASCII CRC32 file, and myfile.out as the verification list file.

Verify the contents of the primary 
disk against a CRC32 file.

ghostpe.exe -CRC32,action=verify,src=1

crcfile=myfile.txt,vlist=myfile.out,vexcept=myfile.exc

Same as above with the inclusion of the EXCEPTION argument 
that excludes compared files based upon its entries.

Verify the contents of the primary 
disk against a CRC32 file.

Use this switch To do this
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The specification of \WINDOWS\COOKIES\*.* in the example above 
means match all files in the subdirectory \WINDOWS\COOKIES that have 
an extension. To match all files with or without an extension, 
WINDOWS\COOKIES\* should be used.

Short file names should be used in exclusion files and files specified before 
the first [Partition:x] heading are used to match files in any partition.

A directory of * matches any subdirectory, regardless of nesting. The above 
exclusion file matches any file with an extension of .1 in any subdirectory 
on the second partition. Apart from this, wildcards should be used for files, 
not for directories.

-crcignore

Ignores CRC errors. CRC errors indicate data corruption. This switch 
overrides the CRC error detection and may allow a corrupted image file to 
be used. Using this switch leaves the corrupted files in an unknown state.

-dd

Dumps disk metrics information to the dump log file ghststat.dmp. The file 
location can be altered using the -dfile=filename switch.

-dfile=filename

Changes the path and file name of the dump log file created using the -dd 
switch. This switch can not be included in the @ ghost switch text file.

-di

Displays diagnostics. This is useful for technical support purposes. For 
each disk present on the machine, the physical attributes such as drive 
number, cylinders, heads, sectors per track, and total sectors are displayed. 
The diagnostics may be redirected to a file and given to Technical Support 
to assist with problem solving.

Example:

ghostpe.exe -di > diag.txt

outputs disk diagnostics to the file diag.txt.

-dl=number

Specifies the number of hard drives present. Valid numbers are in the range 
1-8. This may help when the BIOS does not report the number of drives 
correctly.
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-f32

Allows Norton Ghost to convert all FAT16 volumes to FAT32 volumes when 
the destination partition is larger than 256 MB in size. Ensure that the 
installed operating systems requiring access to the volumes that will be 
converted support FAT32.

-f64

Allows Norton Ghost to resize FAT16 partitions to be greater than 2047 MB 
using 64K clusters. This is only supported by Windows NT and Windows 
2000. Do not use on systems including other operating systems.

-fatlimit

Limits the size of FAT16 partitions to 2047 MB. Useful when Windows NT 
OS FAT16 partitions are present on the disk, and 64K clusters are not 
wanted.

-fcr

Creates a CRC32 file (called ghost.crc) while creating an image file.

-fdsp

Preserves the signature bytes on the destination disk when performing a 
disk-to-disk or image-to-disk cloning operation.

-fdsz

Clears the signature bytes on the destination disk when performing a 
disk-to-disk or image-to-disk cloning operation.

-ffi

Prefer the use of direct IDE access for IDE hard disk operations. This 
switch does not have any effect when running Norton Ghost in Windows 
95/98.

-ffs

Prefer the use of direct ASPI/SCSI disk access for SCSI hard disk operations.

-ffx

Prefer the use of Extended Interrupt 13h disk access for hard disk 
operations.
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-finger

Displays the fingerprint details written on a hard disk created by Norton 
Ghost. The fingerprint displays the process used to create the disk or 
partition and the time, date, and disk the operation was performed on.

-fis

Use all available disk space when creating partitions. By default, Ghost 
often leaves a small amount of free space at the end of the disk. Because 
partitions must be aligned to cylinder boundaries, Ghost may leave up to 5 
MB free even when -fis is specified.

-fni

Disables direct IDE access support for IDE hard disk operations.

-fns

Disables direct ASPI/SCSI access support for SCSI hard disk operations.

-fnx

Disables extended INT13 support for hard disk operations.

-fro

Forces Norton Ghost to continue cloning even if source contains bad 
clusters.

-fx

Flag Exit. Causes Norton Ghost to exit to DOS after operation completion. 
By default, Norton Ghost prompts the user to reboot or exit when the 
operation has finished. See -rb for rebooting on completion.

-h or -?

Displays the Norton Ghost command-line switch help page.

-ia

Image All. The Image All switch forces Norton Ghost to do a 
sector-by-sector copy of all partitions. When copying a partition from a 
disk to an image file or to another disk, Norton Ghost examines the source 
partition and decides whether to copy just the files and directory structure, 
or to do a sector-by-sector copy. If it understands the internal format of the 
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partition, it defaults to copying the files and directory structure. Generally 
this is the best option, however, if a disk has been set up with special 
hidden security files that are in specific positions on the partition, the only 
way to reproduce them accurately on the target partition is through a 
sector-by-sector copy. If you use this switch to create an image of a 
dynamic disk, then the image must be loaded to a disk with identical 
geometry.

-ial

Forces a sector-by-sector copy of Linux partitions. Other partitions are 
copied as normal.

-ib

Image Boot. Copies the entire boot track, including the boot sector, when 
creating a disk image file or copying disk-to-disk. Use this switch when 
installed applications such as boot-time utilities use the boot track to store 
information. By default, Norton Ghost copies only the boot sector, and 
does not copy the remainder boot track. You cannot perform 
partition-to-partition or partition-to-image functions with the -ib switch.

-id

Image Disk. Similar to -ia (Image All), but also copies the boot track, as in 
-ib (ImageBoot), extended partition tables, and unpartitioned space on the 
disk. When looking at an image made with -id, you will see the 
unpartitioned space and extended partitions in the list of partitions. The -id 
switch is primarily for the use of law enforcement agencies who require 
forensic images.

When Norton Ghost restores from an -id image, it relocates partitions to 
cylinder boundaries and adjusts partition tables accordingly. Head, sector, 
and cylinder information in partition tables is adjusted to match the 
geometry of the destination disk. Partitions are not resizeable, and you will 
need an identical or larger disk than the original to restore to.

Norton Ghost does not wipe the destination disk when restoring from an 
-id image. Geometry differences between disks may leave some tracks on 
the destination disk with their previous contents.

Use the -ia (Image All) switch instead of the -id switch when copying 
partition to partition or partition to image. An individual partition can be 
restored from an image created with -id.
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-jl:x=filename

Creates a log file to assist diagnosing problems. The amount of information 
logged is set by the log level ‘x.’ The log level ‘x’ can be E (errors), S 
(statistics), W (warnings), I (information) or A (all) in increasing order of 
logging detail. The file name indicates the path and file where the log will 
be created. In general, the error and statistic levels do not affect session 
performance. All other levels may reduce performance and should be used 
for diagnostic purposes only.

-lockinfo

Displays the type code and information stored in the BIOS, or the Pentium 
III Processor ID.

For example:

-locktype= Type

Lets you lock an image file for use with a specific set of machines defined 
by the type chosen and the source machine.

For example, ghost -locktype=P creates an image that can be used only on 
systems that have the same Product Name type as the source machine.

-lpm

LPT master mode. This switch causes Norton Ghost to automatically go 
into LPT master mode, and is the equivalent of selecting LPT Master in the 
main menu. See “Peer-to-peer connections” on page 16 for more 
information.

Type Based On Value

M Manufacturer Compaq

P Product Name Deskpro EN Series SFF

V Version Compaq

S Serial Number H925CKH60020

U UUID 2DA9379B4707D31185E8C800A4F232BC

C M&P Combined Compaq Deskpro EN Series SFF

I PIII ID 0000067200028E72A6994A20
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-lps

LPT slave mode. This switch causes Norton Ghost to automatically go into 
LPT slave mode, and is the equivalent of selecting LPT Slave in the main 
menu. See “Peer-to-peer connections” on page 16 for more information.

-memcheck

Activates internal memory usage checking for technical support.

-nofile

Disables the Image File Selection dialog box. Useful when opening 
directories with large numbers of files and overly slow links.

-nolilo

Do not attempt to patch the LILO boot loader after a clone. If you use the 
-nolilo switch you will need to boot from a floppy after the clone, and then 
rerun LILO.

-noscsi

Disables accessing SCSI devices via ASPI.

-ntc

Disables NTFS contiguous run allocation.

-ntchkdsk

Cloned NTFS volume will have the CHKDSK bit set. This will cause 
Windows NT to check the integrity of the volume when it is booted.

-ntd

Enables NTFS internal diagnostic checking.

-ntic

Ignores the NTFS volume CHKDSK bit. Norton Ghost checks the CHKDSK 
bit on a NTFS volume before performing operations. When Norton Ghost 
indicates the CHDSK bit is set, we recommend running CHKDSK on the 
volume to ensure the disk is in a sound state before cloning.
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-ntiid

By default, Norton Ghost copies partitions participating in an NT volume 
set, stripe set, or mirror set using Image All sector-by-sector copying. This 
switch forces Norton Ghost to ignore the Windows NT volume set partition 
status and clone the partition as if it were an NTFS partition to allow it to 
be intelligently cloned on a file-by-file basis. Care should be taken when 
using this switch. Use of the -ntiid switch with volume sets and stripe sets 
is not recommended. When cloning mirrored partitions, also known as NT 
software RAID partitions, use the following procedure:

1 With Windows NT disk administrator, break the mirror set.

2 Using the -ntiid switch, clone just one of the mirror partitions, and 
resize as desired. Partitions can only be resized by Norton Ghost 
during a DISK operation. When performing a partition operation, the 
target partition size must already be established. 

3 After cloning, recreate a mirror set using the Windows NT disk 
administrator. The disk administrator creates the partitions in the mirror 
set.

-ntil

Ignores non-empty NTFS log file check (inconsistent volume).

-or

Override. Allows the override of internal space and integrity checks. Use of 
this switch should be avoided. 

-pwd and -pwd=x

Specifies password protection be used when creating an image file.

x indicates the password for the image file. If no password is given in the 
switch Norton Ghost will prompt for one.

-pmbr

Specifies the memory boot record of the destination disk be preserved 
when performing a disk-to-disk or image-to-disk cloning operation.

-quiet

Quiet mode. Disables status updates and user intervention.
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-rb

Reboots after finishing a load or copy. After completing a load or copy 
operation, the target machine must be rebooted so that the operating 
system can load the new disk/partition information. Normally, Norton 
Ghost prompts the user to reboot or exit. -rb tells Norton Ghost to 
automatically reboot after completing the clone. See also -fx switch.

-script

Allows you to specify a series of commands (one per line) and Norton 
Ghost will execute them in a sequential order.

Example:

ghost -script=script.txt

Here is an example of script.txt:

-clone,mode=dump,src=2,dst=c:\drv2.gho

-chkimg,c:\part2.gho

-clone,mode=dump,src=2,dst=c:\part2.gho

-chkimg,c:\part2.gho

-skip=x

Skip File. Causes Norton Ghost to exclude the indicated files during an 
operation. A skip entry can specify a single file, directory, or multiple files 
using the * wildcard. File names must be given in short file name format 
and all pathnames are absolute. Only FAT system files are able to be 
skipped. It is not possible to skip files on NTFS or other file systems. The 
skip switch may only be included in the command line once. To specify 
multiple skip entries, they must be included in a text file indicated using 
-skip=@skipfile. The format of the skip text file skipfile matches the format 
used with the CRC32 vexcept option.

Examples:

-skip=\windows\user.dll

Skips the file user.dll in the windows directory.

-skip=*\readme.txt

Skips any file called readme.txt in any directory.

-skip=\ghost\*.dll 

Skips any file ending with .dll in the ghost directory.
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-skip=\progra~1\

Skips the whole program files directory (note the short file name).

-skip=@skipfile.txt

Skips files as outlined in the skipfile.txt file. For example, the skipfile.txt 
contains:

*\*.tmt

[partition:1]

\windows\

*\*.exe

[Partition:2]

*\*me.txt

This would skip all *.tmt files on any partition, the windows directory and 
any *.exe files on the first partition, and any file that ended with the me.txt 
on the second partition.

-span

Enables spanning of image files across volumes.

-split=x

Splits image file into “x” MB spans. Use this switch to create a forced size 
volume set. For example, if you would like to force smaller image files 
from a 1024 MB drive, you could specify 200 MB segments. For example, 

ghostpe.exe -split=200 

divides the image into 200 MB segments.

-tapebuffered

Default tape mode. Sets the ASPI driver to report a read/write as successful 
as soon as the data has been transferred to memory. Useful when using 
older or unreliable tape devices or sequential media.

-tapeeject

Forces Norton Ghost to eject the tape following a tape operation. Earlier 
versions ejected the tape by default. By default, Norton Ghost does not 
eject the tape and rewinds the tape before exiting to DOS.
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-tapesafe

Sets the ASPI driver to report a read/write as successful only when the data 
has been transferred to the physical medium. Useful when using older or 
unreliable tape devices or sequential media.

-tapesize

Specifies the tape block size in units of 512 bytes.

-tapespeed=x

Allows control of tape speed. Where x equals 0 to F. 0 is default, 1-F 
increases tape speed. Only use this when the tape does not work correctly 
at the speed used by Norton Ghost.

-tapeunbuffered

Sets the ASPI driver to report a read/write as successful only when the data 
has been transferred to the tape drive. (It is possible that this occurs before 
the data is actually physically written to the medium.)

-tcpm[:slave IP address]

TCP/IP master mode. This switch causes Norton Ghost to automatically go 
into TCP/IP master mode, and is the equivalent of selecting TCP/IP Master 
in the main menu. See “Peer-to-peer connections” on page 16 for more 
information. The IP address of the slave machine may be specified.

-tcps

TCP/IP slave mode. This switch causes Norton Ghost to automatically go 
into TCP/IP slave mode, and is the equivalent of selecting TCP/IP Slave in 
the main menu. See “Peer-to-peer connections” on page 16 for more 
information.

-usbm

USB master mode. This switch causes Norton Ghost to automatically go 
into USB master mode, and is the equivalent of selecting USB Master on 
the main menu. See “Peer-to-peer connections” on page 16 for more 
information.
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-usbs

USB slave mode. This switch causes Norton Ghost to automatically go into 
USB slave mode, and is the equivalent of selecting USB Slave on the main 
menu. See “Peer-to-peer connections” on page 16 for more information.

-vdw

If this switch is set, Norton Ghost uses the disk’s verify command to check 
every sector on the disk before it is written. This option may slow Norton 
Ghost operation substantially.

-ver

Displays the version number of Norton Ghost.

-ver=value

Tests the version of Norton Ghost. If Norton Ghost is older than the 
specified version, it aborts and exits, otherwise it proceeds as normal. The 
version number should be specified without the period. For example, 
Norton Ghost 6.5 is -ver=650.

-z

Compress when saving a disk or partition to an image file.

� -z or -z1 low compression (fast)

� -z2 high compression (medium)

� -z3 thru -z9 higher compression (slower)
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 B 
The wattcp.cfg network
configuration file

The wattcp.cfg configuration file contains the TCP/IP networking 
configuration details for Norton Ghost.

The wattcp file specifies the IP address of the machine and the subnet 
mask and allows you to set other optional network parameters. The file 
should be located in the current directory when ghostpe.exe is started.

Comments in the file start with a semicolon (;). Options are set using the 
format: option = value. For example:

receive_mode=5;set receive mode

The keywords in the wattcp.cfg configuration file are the following:

IP Specifies the IP address of the local machine. Each machine must 
have a unique IP address. Norton Ghost supports the use of 
DHCP and BOOTP servers and defaults to using them when the 
IP address is left blank or is invalid. DHCP and BOOTP provide 
automatic assignment of IP addresses to machines. This allows 
identical boot disks to be used on machines with similar network 
cards.

Example: IP=192.168.100.10

Netmask Specifies the network IP subnet mask.

Example: NETMASK=255.255.255.0

Gateway 
(optional)

Specifies the IP address of the gateway. This option is required 
when routers are present on the network and when participating 
machines are located on different subnets.

Example: GATEWAY=192.168.100.1
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Bootpto 
(optional)

Overrides the time-out value (in seconds) for BOOTP/DHCP.

Example: BOOTPTO=60

Receive_Mode 
(Ethernet only)

Overrides the automatically configured packet driver mode used 
by Norton Ghost. The modes in order of preference are 4, 5, and 
6. The default value is 4.
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A P P E N D I X
 C
Troubleshooting

Norton Ghost error codes
A Norton Ghost error message consists of an error number, a description, 
and possibly a suggestion of what can be done to remedy the problem. 
Below is a list of the more common errors that Norton Ghost may report. 
Make sure you are running the latest version as many errors have been 
fixed through revisions.

Refer to Appendix D, “Diagnostics” on page 93 for information on the 
ghosterr.txt file generated when an abort error occurs. Further information 
is available on the Norton Ghost technical support Web site. See “Service 
and support solutions” on page 99.

Error code Description

8006, 8008 The trial period of the evaluation has expired. Visit the Symantec Web site at 
http://www.symantec.com for details on how to purchase Norton Ghost.

10098 The partition number must be included in the command-line switches. See 
Appendix A, “Command-line switches” on page 67 for further information. 

10010,10014, 
11000

Incorrect path/file syntax. Ensure path and file name are correct and complete. 
Also make sure you have the proper user rights to read or create the image file 
on the network.

14030 An unregistered version of Norton Ghost has encountered a file with a date 
beyond its expiration date. Scan your system for files beyond this date and 
temporarily remove them from the system to allow Norton Ghost to continue. 
You can locate the offender by looking at the drive:\path\file name at the bottom 
of the Norton Ghost window when this error occurs. Visit the Symantec Web site 
at www.symantec.com for details on how to purchase Norton Ghost.
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Troubleshooting 
15170 Due to an unformatted or invalid partition on the source hard drive. Make certain 
the source drive is completely allocated as Norton Ghost looks for 100% viable 
media.

19913 Can’t find BOOTP/DHCP server. Check that the computer is connected to the 
network and that a BOOTP or DHCP server is set up for this subnet.

19916 Duplicate IP address detected. An IP address has been allocated that is already in 
use.

CDR101: Not 
ready reading 
drive X, Abort, 
Retry, Fail

A system error message. This error is not caused by Norton Ghost. It is caused by 
malfunctioning hardware or software configurations. The image file on the CD is 
not readable. To verify this, try going into DOS and copying the image file off the 
CD-ROM using copy verification.

Error code Description
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A P P E N D I X
 D
Diagnostics

This appendix contains information that may be helpful for diagnostic 
purposes.

Hard drive detection and diagnostic information
Norton Ghost has the ability to generate several different diagnostic reports 
outlining the hard drive devices detected, other system-related information, 
and error conditions when they are detected.

Norton Ghost abort error file (ghosterr.txt)

An error message consists of an error number, a description, and possibly a 
suggestion of what can be done to remedy the problem.

The Norton Ghost abort error file includes these details along with 
additional drive diagnostics and details required to assist technical support 
in diagnosing the cause of the problem.

The Norton Ghost abort error file is generated when an erroneous 
condition is detected by the software which Norton Ghost is unable to 
recover from or work around. The ghosterr.txt file is generated in the 
current directory. If this location is read-only, the ghosterr.txt file output 
location should be redirected. The location and file name of the abort file 
generated by Norton Ghost during an abort can be altered using the 
-afile=drive:\path\file name command line switch.

For more information on some common error codes, see Appendix C, 
“Troubleshooting” on page 91.
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Diagnostics 
Hard disk geometry diagnostics

A list of all detected hard drives on the system and their associated 
geometry values can be displayed on-screen using the command line 
switch -di. To generate a file containing the details, the DOS redirect 
output can be used as shown in the following example:

c:\ > ghostpe.exe -di > drives.txt

Full diagnostic statistics dump summary

A full diagnostic statistics dump summary file contains the detected hard 
disk geometry details along with other Norton Ghost statistics. The full 
Norton Ghost diagnostic statistics dump can be created using the 
command-line switch -dd. The default statistics dump file name is 
ghststat.txt. The location and file name of a file generated by Norton Ghost 
can be altered by adding the -dfile=drive:\path\file name command-line 
switch.

Elementary network testing techniques

TCP/IP

There are several basic testing utilities available in the Microsoft TCP/IP 
application suite. An example of two Windows 95 TCP/IP utilities, ping.exe 
and winipcfg.exe is included below. On Windows NT, the equivalent 
utilities are ping.exe and ipconfig.exe.

The ping utility shows TCP/IP networking response and can be used to 
show connectivity between computers. For a mapped network volume 
connection, a client can ping the server and vice versa to check that they 
have basic connectivity at any time.

Ping local host shows basic local TCP/IP functionality. The address used in 
the following example is a special address which identifies the local host 
on the network. 
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Elementary network testing techniques
Pinging a local host

In a Windows DOS prompt dialog box on a Windows 95 machine with a 
computer name Win95PC1 the following command was entered:

c:\> ping LocalHost

Pinging Win95PC1 [127.0.0.1] with 32 bytes of data:

Reply from 127.0.0.1: bytes=32 time<10ms TTL=128

Reply from 127.0.0.1: bytes=32 time<10ms TTL=128

Reply from 127.0.0.1: bytes=32 time<10ms TTL=128

Reply from 127.0.0.1: bytes=32 time<10ms TTL=128

This test indicates that the TCP/IP stack is installed and is operating.
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A P P E N D I X
 E 
USB and DirectParallel
Cables

This appendix contains information on USB and DirectParallel cable 
availability and ordering.

Parallel Technologies cables
Parallel Technologies USB and DirectParallel® Universal Fast Cable 
provide high-speed data transfer and can significantly increase Norton 
Ghost performance.

USB and DirectParallel connection cables are available directly from 
Parallel Technologies.

The USB and DirectParallel connection cables can also be used for 
high-speed computer to computer file transfer and networking in Windows 
9x and Windows 2000. Norton Ghost contains DirectParallel driver 
technology from Parallel Technologies, Inc., the developers of the Direct 
Cable Connection computer-to-computer technology built into Windows 9x 
and Windows 2000. The DirectParallel drivers and cables contain 
patent-pending parallel port interface technology.

Via Web site http://www.lpt.com

Via telephone 800.789.4784 (U.S.)
425.869.1119 (International)

Via fax 253.813.8730

Via email sales@lpt.com
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USB and DirectParallel Cables 
Other USB cables
The following USB peer-to-peer cables can also be used with Norton 
Ghost:

� EzLink USB Instant Network, model 2710

� USB LinQ Network

� BusLink USB to USB File Transfer cable, model UFT06
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S U P P O R T
Service and support solutions

Service and support information is available from the Help system of your 
Symantec product. Click the Service and Support topic in the Help index.

Technical support
Symantec offers several technical support options:

� StandardCare support

Connect to the Symantec Service & Support Web site at 
http://service.symantec.com, then select your product and version. 
This gives you access to product knowledge bases, interactive 
troubleshooter, Frequently Asked Questions (FAQs), and more.

� PriorityCare, GoldCare, and PlatinumCare support

Fee-based telephone support services are available to all registered 
customers. For complete information, please call our automated fax 
retrieval service at (800) 554-4403 and request document 933000.

For telephone support information, connect to 
http://service.symantec.com, select your product and version, and 
click Contact Customer Support.

� Automated fax retrieval

Use your fax machine to receive general product information, fact 
sheets, and product upgrade order forms by calling (800) 554-4403. For 
technical application notes, call (541) 984-2490.
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Service and support solutions 
Support for old and discontinued versions

When a new version of this software is released, registered users will 
receive upgrade information in the mail. Telephone support will be 
provided for the old version for six months after the release of the new 
version. Technical information may still be available through the Service & 
Support Web site (http://service.symantec.com).

When Symantec announces that a product will no longer be marketed or 
sold, telephone support will be discontinued 60 days later. Support will be 
available for discontinued products from the Service & Support Web site 
only.

Customer service
Visit Symantec Customer Service online at http://www.symantec.com/
techsupp/news/custserv.html for assistance with non-technical questions 
and for information on how to do the following:

� Subscribe to the Symantec Support Solution of your choice.

� Obtain product literature or trialware.

� Locate resellers and consultants in your area.

� Replace missing or defective CD-ROMS, disks, manuals, and so on.

� Update your product registration with address or name changes.

� Get order, return, or rebate status information.

� Access customer service FAQs.

� Post a question to a Customer Service representative.

For upgrade orders, visit the online upgrade center at:
http://www.symantec.com/upgrades/ or call the Customer Service Order 
Desk at (800) 568-9501.

Worldwide service and support
Technical support and customer service solutions vary by country. For 
information on Symantec and International Partner locations outside of the 
United States, please contact one of the service and support offices listed 
below, or connect to http://www.symantec.com, select the country you 
want information about, and click Go!
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Worldwide service and support
Service and support offices

North America

Argentina, Chile, and Uruguay

Asia/Pacific Rim

Brazil

Columbia, Venezuela, the Caribbean, and Latin America

Symantec Corporation
175 W. Broadway
Eugene, OR 97401

http://www.symantec.com/
(Fax: (541) 984-8020

Automated Fax Retrieval (800) 554-4403
(541) 984-2490

Symantec Region Sur
Cerrito 1054 - Piso 9
1010 Buenos Aires
Argentina

http://www.symantec.com/region/mx
+54 (11) 4315-0889
Fax: +54 (11) 4314-3434

Symantec Australia Pty. Ltd.
408 Victoria Road
Gladesville, NSW 2111
Australia

http://www.symantec.com/region/reg_ap/
+61 (2) 9850 1000
Fax: +61 (2) 9817 4550

Symantec Brazil
Av. Juruce, 302 - cj 11
São Paulo - SP
04080 011
Brazil

http://www.symantec.com/region/br/
+55 (11) 531-7577
Fax: +55 (11) 5530 8869

Symantec América Latina
2501 Colorado, Suite 300
Santa Monica, CA 90404

http://www.symantec.com/region/mx/
+1 (541) 334-6050 (U.S.A.)
Fax: (541) 984-8020 (U.S.A.)
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Service and support solutions 
Europe, Middle East, and Africa

Mexico

Virus protection subscription policy
If your Symantec product includes virus protection, you might be entitled 
to receive free virus protection updates via LiveUpdate. The length of the 
free subscription could vary by Symantec product.

When you near the end of your virus protection subscription, you will be 
prompted to subscribe when you start LiveUpdate. Simply follow the 
instructions on the screen. After your free subscription ends, you must 
renew your subscription before you can update your virus protection. 
Renewal subscriptions are available for a nominal charge.

To order a subscription, do one of the following:

� Visit our Web site at: http://www.shop.symantec.com.

� Outside the United States, contact your local Symantec office or 
representative.

Every effort has been made to ensure the accuracy of this information. 
However, the information contained herein is subject to change without 
notice. Symantec Corporation reserves the right for such change without 
prior notice.

July 2000

Symantec Customer Service Center
P.O. Box 5689
Dublin 15
Ireland

http://www.symantec.com/region/reg_eu/
+353 (1) 811 8032
Fax: +353 (1) 811 8033

Automated Fax Retrieval +31 (71) 408-3782

Symantec Mexico
Periferico Sur No. 3642, Piso 14
Col. Jardines del Pedregal
09100 Mexico, D.F.

http://www.symantec.com/region/mx
+52 (5) 661-6120; +1 (800) 711-8443
Fax: +52 (5) 661-8819
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Norton Ghost 2001

CD Replacement Form

FOR CD REPLACEMENT
Please send me:    ___ CD Replacement

Name ________________________________________________________________________________________________________________

Company Name _______________________________________________________________________________________________________

Street Address (No P.O. Boxes, Please)_____________________________________________________________________________________

City ______________________________________________________________________ State _______ Zip/Postal Code _________________

Country* _________________________________________________________Daytime Phone _______________________________________

Software Purchase Date _________________________________________________________________________________________________

*This offer limited to U.S., Canada, and Mexico. Outside North America, contact your local Symantec office or distributer.

Briefly describe the problem:_____________________________________________________________________________________________

______________________________________________________________________________________________________________________

FORM OF PAYMENT ** (CHECK ONE):
___  Check (Payable to Symantec)  Amount Enclosed  $ _________ __ Visa       __ Mastercard      __  American Express

Credit Card Number ___________________________________________________________________________________Expires __________

Name on Card (please print) ________________________________________________ Signature ___________________________________

**U.S. Dollars. Payment must be made in U.S. dollars drawn on a U.S. bank.

MAIL YOUR CD REPLACEMENT ORDER TO:
Symantec Corporation

Attention:  Order Processing

175 West Broadway

Eugene, OR  97401-3003    (800) 441-7234

Please allow 2-3 weeks for delivery within the U.S.

Symantec and Norton Ghost are trademarks of Symantec Corporation.
Other brands and products are trademarks of their respective holder/s.
 2000 Symantec Corporation. All rights reserved. Printed in the U.S.A.

CD REPLACEMENT: After your 60-Day Limited Warranty, if your CD becomes unusable, fill out and return 1) this form, 2) your
damaged CD, and 3) your payment (see pricing below, add sales tax if applicable), to the address below to receive replacement CD.
DURING THE 60-DAY LIMITED WARRANTY PERIOD, THIS SERVICE IS FREE.  You must be a registered customer in order to receive CD
replacements.

CD Replacement Price   $ 10.00
Sales Tax (See Table) ______
Shipping & Handling $   9.95

TOTAL DUE ______

SALES TAX TABLE: AZ (5%), CA (7.25%), CO (3%), CT (6%), DC (5.75%), FL (6%), GA (4%), IA (5%), 
IL (6.25%), IN (5%), KS (4.9%), LA (4%), MA (5%), MD (5%), ME (6%), MI (6%), MN (6.5%), MO (4.225%),
NC (6%), NJ (6%), NY (4%), OH (5%), OK (4.5%), PA (6%), SC (5%), TN (6%), TX (6.25%), VA (4.5%), WA (6.5%), 
WI (5%).  Please add local sales tax (as well as state sales tax) in AZ, CA, FL, GA, MO, NY, OH, OK, SC, TN, TX, WA, 
WI. 
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I N D E X
Symbols
#e=filename switch 68
? switch 79
@filename switch 67

A
abort log 68, 93
afile=filename switch 68
ASPI driver 14, 16
auto switch 68
automation

clone switch and examples 69
close on completion 79
quiet mode 83
reboot on completion 84
switches 67-87
version checking 86, 87

B
bfc=x switch 68
boot disk 32

setup 29, 30
boot package

creating 23
bootcd switch 68

C
cables 97
CD-ROM 15
chkimg,filename switch 68
clone switch 69
command line

examples 72-76
Ghost 67-87

compression. See image files
copy command 69
CRC32 46, 73-77, 78

crc32 switch 73
crcignore switch 77

D
dd switch 77
dfile=filename switch 77
di switch 77
diagnostics 93-95
dl=number switch 77
dst switch 70
dump command 69

F
f32 switch 78
f64 switch 78
fatlimit switch 78
fcr switch 78
fdsp switch 78
fdsz switch 78
ffi switch 78
ffs switch 78
ffx switch 78
file system

FAT12 54
FAT16 54

Windows NT 63, 78
FAT32 54

conversion from FAT16 78
Linux Ext2 54, 61
NTFS, switches 82

files, skipping 84
finger switch 79
fingerprint. See Ghost
fis switch 79
fni switch 79
fns switch 79
fnx switch 79
fro switch 79
fx switch 79
Search the online help index for more information. 105



G
Gdisk 10
Ghost

environment file 68
fingerprint 79
hardware requirements for cloning 15
introduction 9
scenarios 11
See also uninstalling
See also procedures

hard disk, See also procedures
Ghost Boot Wizard 10, 23-29
Ghost executable 10
Ghost Explorer 10, 53-58

command line 57
Ghost GDISK 58

batch mode 62
command line switches 59

Ghost operation, operating system 32
ghost.err. See abort log
ghost.exe 10

H
h switch 79
hard disk

active 59
batch 59
creating 59
deleting 59, 64
hiding partitions 59
large drives 66
MBR 59
status 59
wiping 64

hardware requirements for cloning 15

I
ia switch 79
ial switch 80
ib switch 80
id switch 80

image files 54
compression 35, 45-46, 87
CRC. See CRC32
creating

insufficient space 47
See also image files multi-segment
See also image files spanned

features 9, 45
file list 55
loading 48
modification 55
multi-segment 47, 68, 85
password 83
restoring 54
size limited. See image files multi-segment
spanned 47-49, 55, 68, 85
split. See image files multi-segment
standard 46
viewing contents 54

J
jl

x=filename switch 81

L
load command 69
lockinfo switch 81
locktype=type switch 81
lpm switch 81
lps switch 82
LPT support 24
LPT. See parallel port transfer

M
master 17
MBR, reinitializing 59
memcheck switch 82
mode switch 69
Multicast Assist Wizard

See also Ghost Boot Wizard
106 Search the online help index for more information.



N
NetBIOS 15

setup 14
nofile switch 82
nolilo switch 82
Norton Ghost

See also Ghost
noscsi switch 82
ntc switch 82
ntchkdsk switch 82
ntd switch 82
ntic switch 82
ntiid switch 83
ntil switch 83

O
Open 54
operations. See procedures
or switch 83

P
parallel port transfer 15

automation 81, 86
setup 14, 17

pcopy command 69
pdump command 69
Peer 15
peer to peer connection

LPT. See parallel port transfer
ping utility 94
pload command 69
pmbr switch 83
procedures

disk 33-37
from image file 36-37
to disk 33-34
to image file 35-36

partitions 38-42
from image file 41-42
to image file 39-41
to partition 38-39

pwd, -pwd=x switch 83

Q
quiet switch 83

R
rb switch 84
removable media 15

S
script switch 84
SCSI tape 15

setup 16
switches 85-86

sector by sector copy 79
sector, bad 68, 79, 87
service and support 99
Setting 13
setup 16-17

See also parallel port transfer
See also SCSI Tape

skip=x switch 84
slave 17
span switch 85
spanning 47-49
split=x switch 85
src switch 69
Support 66
Symantec Ghost

See also Ghost
sze switch 71

T
tapebuffered switch 85
tapeeject switch 85
tapesafe switch 86
tapesize switch 86
tapespeed=x switch 86
tapeunbuffered switch 86
tcpm switch 86
tcps switch 86
technical support 99
Search the online help index for more information. 107



U
uninstalling 20
USB

See also peer-to-peer connection
USB support 24
usb switch 87
using

Ghost Explorer 53-58

V
vdw switch 87
ver switch 87
ver=value switch 87
vexcept switch 76

W
wattcp.cfg 89
Windows, running Ghost inside 32

Z
z switch 87
108 Search the online help index for more information.
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